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Introduction
Welcome to Mocha, tracking and rotoscoping tools that make your tracking and

rotoscoping work much easier.

Our tools are based on our proprietary Planar Tracking technology, an awesome

approach to 2D tracking which will help you to generate accurate corner-pins and

track and transform your roto splines in a powerful way.

The Art of Tracking

Tracking and rotoscoping are part of almost any visual effects project. For 2D

tracking, point trackers are most commonly used, but to get good point tracks

requires a mix of experience and luck. You often have to "prime" a clip for

optimum tracking using color correctors and other image manipulations. If the

point being tracked exits frame, you get into offset tracking, which presents its

own set of challenges. If it all fails, you are into hand tracking, which is time

consuming and very hard to get accurate.

Mocha is a 2D tracker that requires less experience and luck to be successful

with, does not require the image to be primed and is less likely to require a lot of

tricks or hand tracking on difficult shots.

There Are No Point Trackers

In Mocha splines are used for both tracking and rotoscoping. This is a different

method from standard 1-point or multi-point tracking tools.

Traditional tracking tools require that you locate "points" that remain consistent

throughout the entire shot in order to track movement. This is itself a difficult task,

especially when tracking a shot that was not originally designed to be tracked. If

you wish to also track rotation, perspective and shear you need even more clear

and consistent points to track.

Traditional roto methodology would have you outline a shape with the minimum

number of points necessary then either manually move the control points or track

the shape with a point tracker to "get it close". Even when using multi-point

trackers to impart rotation and scale to the roto spline, the results are often
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unusable if there is any perspective change during the shot.

Instead, Boris FX’s Planar Tracker tracks an object’s translation, rotation and

scaling data based on the movement of a user-defined plane.

A plane is any flat surface having only two dimensions, such as a table top, a wall,

or a television screen. Planes provide much more detail to the computer about an

object’s translation, rotation and scaling than is possible with point-based tracking

tools. Even as an object leaves and enters a frame, there is usually enough

information for the Planar Tracker to maintain a solid track of the object.

When you work with the Mocha tools, you will need to look for planes in the clip.

More specifically, you will need to look for planes that coincide with movements

you want to track. If someone is waving goodbye, you can break their arm into

two planes - the upper and lower limbs. Although not all of the points on the arm

sections actually lie on the same two-dimensional surface, the apparent parallax

will be minimal.

With the addition of PowerMesh in Mocha Pro, subplanar tracking is also possible,

tracking warp and bending of objects that standard planar tracking would struggle

to do alone.
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Interface Overview
To quickly get familiar with Mocha before you dive into the rest of the manual,

here is a breakdown of the interface and its controls.



Some parts of the Interface Overview uses the Mocha Pro

Interface. Versions of the Mocha Pro Plugin, Mocha HitFilm, Mocha

for After Effects etc. may differ in presentation, but their tools

perform the same function

Layouts

Mocha layouts are modifiable, allowing you to hide or reveal many parts of the

interface.

These layouts are clustered into 4 default types you can build from.

Essentials Layout

Mocha begins in the Essentials layout, which provides a simplified interface for

basic tracking and roto.
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The basic toolbar provides a minimal set of tools without cluttering the interface.

The Essentials panel on the left side of the window combines everything you need

for a basic track.
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The Panel contains the following features (from top to bottom):

Track Motion Options

The 5 motion types you can track in:

1. Translation

2. Scale

3. Rotation

4. Shear (sometimes known as Skew)

5. Perspective

Track Buttons

For tracking backwards, forwards and to stop the track

Link to Track

To attach a spline layer to an existing track, or detach it from a track entirely.

See Tracking Basics and Rotoscoping Basics for more information on the benefits

of Link to Track.

Surface

These buttons control viewing and expanding the surface.

See Tracking Basics for how to use the surface effectively.

• Show surface (tracking data): Reveals the blue surface that represents the

tracking data.

• Show grid: Reveals a useful grid for lining up the surface or monitoring for drift

in a track.

• Align surface: Expands the surface to fit the dimensions of the footage on the

current frame.

Classic Layout

For Mocha veterans, the Classic layout is arranged like the original Mocha.
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Use this mode if you are familiar with Mocha and want access to all the

parameters and tools.

Roto Layout

Like the Essentials layout, this layout is optimized specifically for roto sessions

where only the most necessary panels and tools are shown.

Big Picture Layout

If you want to reduce all clutter entirely, the Big Picture layout is very useful for

previewing shots without any elements getting in the way.

Saving Custom Layouts

You can add or remove many parts of the Mocha interface, such as:

• Timeline controls

• Toolbars

• View controls

• Etc.
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These can either be access by right clicking the area of the interface and

choosing a GUI element to show or hide, or selecting from the View menu.

Any changes you make to a layout will not be saved unless you choose View |

Layout | Save Current Layout.

For example if you like the Essentials layout, but would like the Advanced toolbar

from the Classic layout:

1. Choose "Essentials" from the layout drop-down

2. Choose "Advanced Tools" from View | Toolbars

3. Choose View | Layout | Save Current layout

This will now save the Essentials layout with the new toolbar.

Alternatively, you can save the layout as a new custom layout:

1. Make changes to your existing layout

2. Choose View | Layout | Save Current layout as…

3. Enter the new name in the Manage Custom Layouts dialog

You can add, order or remove layouts from the Manage Custom Layouts dialog in

the same sub-menu.

Any new layout will automatically be assigned a Ctrl/CMD + Number shortcut

based on the order of the layouts, up to 9.

If you have made changes to a saved layout want to revert back to the saved

version, just choose View | Layout | Revert to saved.

If you want to revert back to the original default layout, just choose View |

Layout | Revert to default.

Saving Layouts

You can add or remove many parts of the Mocha interface, such as:

• Timeline controls

• Toolbars
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• View controls

• Etc.

These can either be access by right clicking the area of the interface and

choosing a GUI element to show or hide, or selecting from the View menu.

Any changes you make to a layout will not be saved unless you choose View |

Layout | Save Current Layout.

For example if you like the Essentials layout, but would like the Advanced toolbar

from the Classic layout:

1. Choose "Essentials" from the layout drop-down

2. Choose "Advanced Tools" from View | Toolbars

3. Choose View | Layout | Save Current Layout

This will now save the Essentials layout with the new toolbar.

If you have made changes to a saved layout want to revert back to the saved

version, just choose View | Layout | Revert to saved.

If you want to revert back to the original default layout, just choose View |

Layout | Revert to default.

The Advanced Toolbar

At the very top of the interface you have the tools that form the brunt of your time

inside Mocha.

Save Project: Save the project

Select: Selection tool for splines and points. Hold the

button to choose between Marquee selection and

Lasso selection.
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Select Both: Selects both the Inner spline points and

the edge points. Hold this button down to select

further options (See below)

Select Inner: Only selects the inner spline points

Select Edge: Only selects the outer edge points

Select Auto: Automatically selects between Inner and

Edge points

Add Point: Tool to add points to the spline

Pan: Used to pan the footage in the Viewer

Zoom: Used to zoom into footage in the viewer

Create X-Spline Layer: Draw a new X-Spline layer

Add X-Spline to Layer: Draw an X-spline that is added

to the current spline layer.

Create Bezier-Spline Layer: Draw a new B-Spline

layer

Add Bezier-Spline to Layer: Draw a B-spline that is

added to the current spline layer.

Create Rectangle X-Spline Layer: Draw a new

Rectangle X-Spline layer

Add Rectangle X-Spline to Layer: Draw an Rectangle

X-spline that is added to the current spline layer.

Create Rectangle Bezier-Spline Layer: Draw a new

Rectangle B-Spline layer

Add Rectangle Bezier-Spline to Layer: Draw a

Rectangle B-spline that is added to the current spline

layer.

Create Circle X-Spline Layer: Draw a new Rectangle

X-Spline layer

Add Circle X-Spline to Layer: Draw an Rectangle X-

spline that is added to the current spline layer.

Create Circle Bezier-Spline Layer: Draw a new

Rectangle B-Spline layer
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Add Circle Bezier-Spline to Layer: Draw a Rectangle

B-spline that is added to the current spline layer.

Attach Layer: Used to select a point and drag-lock it

to another layer’s spline point. Useful for lining up

individual splines.

Rotate: Rotate selection around the axis of the point

you click in the viewer

Scale: Scale Selection

Move: Move selection

Transform Tool: Toggles the transform bounding box

for manipulating selections

Show Planar Surface: Toggles the planar surface view

Show Planar Grid: Toggles a grid relative to the planar

surface view. You can adjust the number of grid lines

under Viewer Preferences (See below)

Align Surface: Expands the layer surface to fit the

dimensions of the footage at the current frame. All

tracked data is made relative to this new alignment.

Basic Toolbar

In Essentials Mode, only a basic set of tools are shown, to simplify the interface.

The only tools shown here are:

Save Project: Save the project

Select: Selection tool for splines and points. Hold the

button to choose between Marquee selection and

Lasso selection.

Pan: Used to pan the footage in the Viewer

Zoom: Used to zoom into footage in the viewer
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Create X-Spline Layer: Draw a new X-Spline layer

Add X-Spline to Layer: Draw an X-spline that is added

to the current spline layer.

Create Bezier-Spline Layer: Draw a new Bezier-Spline

layer

Add Bezier-Spline to Layer: Draw a Bezier-spline that

is added to the current spline layer.

Create Rectangle X-Spline Layer: Draw a new

Rectangle X-Spline layer

Add Rectangle X-Spline to Layer: Draw an Rectangle

X-spline that is added to the current spline layer.

Create Rectangle Bezier-Spline Layer: Draw a new

Rectangle B-Spline layer

Add Rectangle Bezier-Spline to Layer: Draw a

Rectangle B-spline that is added to the current spline

layer.

Create Circle X-Spline Layer: Draw a new Rectangle

X-Spline layer

Add Circle X-Spline to Layer: Draw an Rectangle X-

spline that is added to the current spline layer.

Create Circle Bezier-Spline Layer: Draw a new

Rectangle B-Spline layer

Add Circle Bezier-Spline to Layer: Draw a Rectangle

B-spline that is added to the current spline layer.

Show Planar Surface: Toggles the planar surface view

Show Planar Grid: Toggles a grid relative to the planar

surface view. You can adjust the number of grid lines

under Viewer Preferences (See below)

Align Surface: Expands the layer surface to fit the

dimensions of the footage at the current frame. All

tracked data is made relative to this new alignment.

See descriptions in Advanced Toolbar above for the rest of the tools.
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The Viewer Controls

These controls cover what can been seen or hidden while working in the Mocha

viewer.


The Viewer controls are turned off in some layouts. You can turn

them on via the View menu.

Clip to Show: Choose which clip to view from this

dropdown

Proxy Scale: Adjust the resolution of the footage for

performance (Mocha Standalone only)

Show RGB Channels: Turns on the RGB view of the

footage. Select from the dropdown to choose an

individual color channel to view.

Show Alpha Channels: Turns on the Alpha view of the

footage

Show Layer Mattes: Toggle on or off to show the

mattes. Select from the dropdown to choose the type

of matte

Color Layer Mattes: Fills matte with Color. Decreasing

the value lessens the opacity

Overlays: Toggles all viewer overlays, including

splines, tangents, surface and grid

Show Layer Outlines: Toggles all spline overlays,

including splines, points and tangents
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Show Spline Tangents: Toggles spline tangents view.

Select from the dropdown to choose the type of view

Show Zoom Window: Toggles the Zoom window

Stabilize: Turns on Quick Stabilize Preview. This

centers the footage around your tracked surface

using the tracking data linked to pan and zoom. You

can choose different layers to stabilize the viewer

from the dropdown in the button.

Trace: Turns on the traced path of the tracked

surface. You can adjust the amount of frames to trace

under Viewer Preferences (See below)

Enable Brightness/Gamma Scaling: Toggles non-

destructive brightness and gamma adjustment to

work with low-contrast footage. The left field adjusts

brightness, the right field adjusts gamma.

Viewer Preferences: Adjustments dialog for

parameters such as grid lines and trace frames. Also

controls for viewer OCIO colourspaces.

The Timeline Controls

The timeline controls cover frame range, playback, tracking controls and key-

framing.


Some timeline controls may not be visible in certain layouts. You

can turn them on via the View menu or by right-clicking the

timeline.

Project In-Point: Frame where timeline

playback starts

Set In-Point: Set the in-point for the

timeline
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Reset In-Point: Set the in-point back to

the start of the clip

Current Frame: The frame the playhead

is currently on. Enter a new value to

jump to that frame.

Reset Out Point: Set the out point back

to the end of the clip

Set Out Point: Set the out point for the

timeline

Project Out Point: Frame where timeline

playback ends

Zoom Timeline to In/Out points: Expands

the timeline between the in and out

points to the edges of the viewer

Zoom Timeline to full frame range:

Resets the timeline scale to the full

range of frames

Play Controls: Controls for playing back

and forth and moving one frame at a

time

Change Playback Mode: Toggles tri-

state button between Play once, Loop

and Bounce playback modes.

Tracking Controls: Controls for tracking

back and forth and tracking one frame

at a time.

Go to Previous Keyframe: Jump to the

previous keyframe set in the timeline for

that layer

Go to Next Keyframe: Jump to the next

keyframe set in the timeline for that

layer
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Add New Keyframe: Add a new

keyframe at the current position for the

selected layer. This only appears if you

are not hovering over an existing

keyframe.

Delete New Keyframe: Deletes the

keyframe at the current position for the

selected layer. This only appears if you

are hovering over a keyframe.

Delete All Keyframes: Deletes all

keyframes on the timeline for the

selected layer

Autokey: Toggles automatic key

insertion when moving points or

adjusting parameters

Überkey: Toggles the Überkey, which

modifies all keys in the layer relative to

the key you are now on.

Layer Controls
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The top left hand panel contains the tools to manage layers.

Layer Icons:

• Click the Eye to toggle layer visibility

• Click the Cog to toggle tracking for

that layer

• Click the Lock to toggle locking

• Click the Spline Color to change the

color of the selected layer splines

• Click the Matte Color to change the

color of the selected layer mattes
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Layer Actions dropdown:

• Select All: Selects all layers

• Select Group: Selects all layers in a

selected group

• Invert Selection: Inverts the layer

selection

• Delete Selected: Deletes all selected

layers

• Duplicate: Duplicates all selected

layers

• Lock Selected: Locks all selected

layers

• Lock All: Locks all layers

• New Group: Creates a new empty

group

• Group Selected: Creates a group

containing the selected layers

• Align Selected Surfaces: Aligns the

selected layer surfaces to the

dimensions of the footage at the

current frame

• Toggle Active at current frame:

Activates or Deactivates the layer on

the current frame

Group Layer: Groups the currently

selected layers. If no layers are

selected, creates an empty group.

Duplicate Layer: Duplicates the

currently selected layers

Delete Layer: Delete currently selected

layers on all frames
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Layer Properties

The section under the Layer Controls panel contains the properties for each layer.

• Layer In/Out frames: Settings to change where the layer turns on and off in the

clip

• Blend mode: Dropdown to add or subtract your spline to the current layer.

Invert flips this

• Insert Clip: Insert a demo clip to preview your track. You can use one of the

default clips to test the tracked insert. For preview purposes only.

• Link to Track: Which layer’s track to link your layer splines to. Can also be set

to None.

• Link to adjusted track: Optional checkbox to link the layer splines to the

adjusted track of the selection in "Link to Track"

Cache Management

In Mocha v5 we introduced manual cache clearing to allow you to clear the Mocha

cache at the project, render or global level.

You can access the Clear Cache option from the file menu under File → Clear

Cache…
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You can check the following options:

• Project Cache: Clear the cache for the currently loaded project

• Rendered Clips: Clear just the rendered clips for the project

• Global Cache: Clear everything in the entire Mocha cache.

Only clear the Global Cache if you are certain you don’t want any of your existing

project caches to remain.
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Using the Mocha AE Plugin
The Mocha AE plugin can be applied as an effect directly onto layers in After

Effects.

This reduces the need to swap out of your application and streamlines getting

data in and out of Mocha.

The biggest advantage is you can set up layers and module settings in Mocha as

normal, and then have the results render directly to the host timeline without

having to export.

Applying the Mocha Plugin for Adobe After Effects

The Mocha AE Plugin for Adobe appears in the Effects menu like any other effect.

You can find it in the Boris FX Mocha sub menu.

Alternatively, you can choose Track in Boris FX Mocha from the After Effects

Animation menu.

Simply select the layer you want to work with and apply the effect to the layer.
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The general workflow for the Mocha Adobe Plugin is as follows:

1. Select the layer you want to track or rotoscope

2. Select the Mocha effect from Effects | Mocha | Mocha AE or optionally choose

"Track in Boris FX Mocha" from the Animation menu.

3. Launch Mocha. This will load a full version of the Mocha interface that you can

use just like the standalone version.

4. Use Mocha as required and then close and save. No rendering is required

inside Mocha.

5. Choose whether you want to use mattes or tracking data from Mocha back in

the plugin interface.

Using the Mocha GUI

Once you have applied the Mocha AE effect, you can click on the Mocha button to

launch the main interface.
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This then becomes exactly like working in the standalone version of Mocha, with a

few exceptions.

First, you will notice you don’t need to set up a project like in the standalone

version. The source layer is automatically loaded and ready to track in the view.

Secondly you don’t need to save out a project file (unless you want to export it).

You just close and save the Mocha view when done and the project is saved

inside the Effect like any other Adobe effect.

For further details on how to track and roto inside the Mocha GUI, see the rest of

the User Guide:

• Mocha Tracking Basics

• Mocha Rotoscoping Basics


The Mocha AE Plugin interface is almost exactly the same as the

standalone interface, so most of the usual guide and video tutorials

can be applied to the plugin.

Controlling Mattes

Once you have tracked layers in Mocha, you can then control the mattes for these

layers back in the plugin interface.

• View Matte: Show the black and white matte from the Mocha layers chosen.

This is very useful if you want to just see any problems with the matte, or you

want to use the output as a track matte.

• Apply Matte: Applies the chosen mattes to the current layer,

• Visible Layers: This button launches the Visible Layers dialog so you can select
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the layers you want visible as mattes.

• Shape: This drop down lets you switch between All Visible and All mattes. All

Visible mattes are controlled by the Visible Layers dialog.

• Feather: Applies a blur to the matte. This feathering is independent of the

feathering of the individual layers inside Mocha.

• Invert Mask: Inverts the currently visible mattes.

• Create AE Mask: Creates native AE splines on the effect layer just like "Paste

Mocha mask". This function is only available in After Effects.

Controlling Tracking Data

If you have a tracked layer in Mocha you can see the output of its surface back in

the After Effects interface.

Each point in the Tracking Data section is a point from the layer surface that

automatically updates when you modify it inside Mocha.

To choose a layer to create tracking data from, click the 'Create Track Data'

button in the Tracking Data section of the plugin.

Then choose the layer you want to read tracking data from in the dialog that

appears. You can only choose one layer at a time.
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Once you click OK, the plugin will generate keyframes to populate the tracking

parameters in the plugin. You can then use this data to copy to other layers, or link

via expressions.


Generating keyframe data can take some time for very long shots.

You can cancel generation at any time when the progress bar

appears.

Applying Tracking Data Exports to Other layers

The plugin interface also allows you to apply tracking data to other layers without

needing to export from the Mocha GUI.

Do do this, you generate the tracking data from a layer, as described above in

Controlling Tracking Data.

You can then choose an export option at the bottom of the Tracking Data section:

• Corner Pin: A standard corner pin effect

• Corner Pin (Support Motion Blur): A corner pin distortion with separate scale,

rotation and position.

• Transform: Scale, position and rotation

Clicking 'Apply Export' then copies the information to the specified layer.
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Tracking Basics



Some tools, parameters and techniques listed below may not be

visible in Essentials mode. To see additional interface elements,

switch to Classic mode. See the Layouts section for more

information.

The Planar Tracker

Boris FX’s Planar Tracker technology provides 2D tracking data by tracking planes

rather than points.

The key to getting the most out of the Planar Tracker is to learn to find planes of

movement in your shot which coincide with the object that you want to track or

roto. Sometimes it will be obvious - other times you may have to break your object

into different planes of movement. For instance if you were tracking a tabletop,

you would want to draw the spline to avoid the flower arrangement in the center

of the table — it is not on the same plane and will make your track less accurate.

To select a plane you simply draw a spline around it. You can be fairly loose with

your spline — the Planar Tracker is intelligent enough to discard the pixel

movement that doesn’t conform to the movement of the majority of the pixels

within the shape.

Mocha features two spline types, X-Splines and Bézier splines:

X-Spline

In general X-Splines work better for tracking, especially with perspective motion.

We recommend using these splines where possible.
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Bézier Spline

Bézier Splines are also very versatile for roto and is the industry spline standard.

CPU vs GPU Tracking

You can choose between a GPU or a CPU tracker in Preferences. By default, GPU

is selected, but will fall back to CPU if an operation is not supported by the GPU

version.

The GPU option allows you to select any supported graphics card on your system

to take on the brunt of the tracking process. The resulting speed improvement is

especially noticeable on high resolution footage or when tracking large areas.

The Relationship Between Splines and Tracking Data

One of the most important concepts to understand with the Mocha planar tracking

system is that the spline movement is not the tracking data.
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It’s best to think of the splines you draw around objects as search areas. Here’s a

breakdown of how the tracking works:

1. By default, any spline you draw is linked to the tracking data of the layer it is

currently in. In hierarchical terms, the spline is the child of the track, even if

there is no tracking data.

2. When you begin to track a layer, the area of detail contained within the

spline(s) you have drawn will be searched for in the next frame.

3. If the planar tracker finds the same area in a following frame, it will tell the

tracker to move to that point. Because the spline is linked to the track by

default, it will also move along with it and the search begins again for the next

frame.

To see this relationship, turn on your surface and/or grid in the viewer after you

have tracked something. Scrub the timeline and you will see that the grid and

surface move with the spline.

Now select all the points of your spline and move it around the viewer. You will

notice that the surface/grid will stay in the same place.

This is because the spline is linked to the track, but the track is not linked to the

spline. The spline is merely a search area to tell the track where to go next. It is a

common misconception that moving the spline while tracking is affecting the

movement of the tracking data. It is not. Moving the spline is only telling the

tracker to look in a different place and will not directly affect the motion of the

tracking.

This makes the tracker very powerful, as you can move and manipulate your

spline area around while tracking to avoid problem areas or add more detail for

the search.

You can even unlink the spline from the track entirely so that any planar surface

passing under the stationary spline area is tracked and you don’t have to move

the spline if tracking starts to go off screen.

Selecting an Area to Track

With the Planar Tracker you simply draw a spline around something, as shown
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with the screen below.

1. Select one of the spline tools to create a shape around the outside edge of the

area you wish to track.

2. Start creating your shape by clicking onto the screen.

3. After the third point, the shape will auto-close, but you can continue to add

points.

4. When drawing splines it is best to keep the shape not tight on the edge, but

actually give a little space to allow for the high contrast edges to show

through, as these provide good tracking data.

5. Right-click to finish drawing.

6. If you are using the X-Spline tool you can adjust the handles at each point by

pulling them out to create a straight cornered edge, or pull them in to make
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them more curved. Right clicking a handle will adjust all the handles in the

spline at once.

Dealing With Obstructions or Reflective Surfaces

In some cases there are parts of an image that can interfere with the

effectiveness of the Planar Tracker. To handle this, you can create an exclusion

zone in the area you are tracking.

For instance, in the phone example we are using, there are frames where there

are strong reflections on the screen. These reflections can make the track jump.

So we need to isolate that area so the tracker ignores it. Here’s how this is done:

1. Select the initial layer you created.

2. Select the add shape tool to add an additional shape to the current layer,

which selects the area you want the tracker to ignore.

3. Draw this second shape inside the original shape. Note that both splines have

the same color, which is an indication that they belong to the same layer. Also

you will notice in the Layer Controls panel that you only have a single layer.
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4. By turning on the Mattes button under View Controls you can see the area that

will be tracked.
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You can also add as many entirely new layers on top of your tracking layer to

mask out the layers below.



The tracking layer uses the matte data of the combined layers you

have drawn. This matte is the outer edge of the tracking layer

matte minus the inner edge of the layers in front, regardless of

feathering.

This is quite common when moving people, limbs, cars, badgers etc. get in front of

the object you are trying to track.

Tracking Parameters

In the Essentials layout, tracking Motion parameters are listed in the Essentials

Panel:
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In the Classic layout, detailed tracking parameters can be accessed by selecting

the Track tab. On the left hand side of the Track tab, you will see two sections:

Motion and Search Area.


Below, we show the Mocha Pro tracking parameters. Mocha AE and

Mocha Hitfilm will only show the planar tracking parameters:

Understanding the parameters section of the Track parameters is vitally important

for obtaining good tracks. Here we provide a breakdown of each parameter and

how to use it effectively.

Input Clip

This is the clip you are going to track. By default it is the one currently in the

viewer.
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Preprocessing [Mocha Pro Only]


This is a Mocha Pro tracking feature. Mocha AE and Mocha Hitfilm

will not have this feature.

This button opens the Preprocessing panel, which has controls for applying non-

destructive clip processing for better tracking results:

Any preprocessing adjustments will be automatically previewed while you are

adjusting the controls.

• Blur: Blurs the source clip. Useful when there is heavy interference like snow,

heavy rain, etc.

• Sharpen: Sharpens the source clip. Useful when there is low detail in the

image.

• Contrast: Contrasts the source clip. Good for low-detail (or low contrast)

images

• Gamma: Increases the gamma in the image. Note this differs from the gamma

view control which does’t affect the clip.

• Denoise: Reduces noise in the image. Especially useful for very noisy images.

• Remove Flicker: Balances flickering footage. This requires using the Reference

Frame button

• Set Reference Frame: Used with Remove Flicker above. This defines the

Reference frame to take the luminance levels to adjust to.

• Preview: Permanently previews the preprocessing adjustments

• Apply to All: Applies the same preprocessing to all layers. If this is off, the

preprocessing only happens to the current layer.
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
We recommend trying to track the shot before attempting

preprocessing. The planar tracker is very robust and will often track

through many problem areas.

Input Channel

When tracking, Mocha looks at contrast for detail. The input channel determines

where to look for that contrast.

• Luminance looks for contrast in the light and dark of the image

• Auto Channel looks for contrast in one of the color channels.

• Red, Green and Blue channels look only in that one color channel for the detail.

By default, Luminance does a good job. If you have low-luminance footage or you

are not getting a good track, try one of the color channels or Auto Channel.

Min % Pixels Used

One of the most important parameters to look at for tracking.

By default, the minimum percentage of pixels used is dynamic. When you draw a

shape, Mocha tries to determine the optimal amount of pixels to look for in order

to speed up tracking. If you draw a very large shape, the percentage will be low. If

you draw a small shape, the percentage will be high.

In many cases, the cause of a drifting or slipping track is a low percentage of

pixels. If you want a more solid and accurate track, try setting the Min % Pixels

Used value to a higher amount. Keep in mind however that a larger percentage of

pixels can mean a slower track.

Smoothing Level

This value blurs the input clip before it is tracked. This can be useful when there is

a lot of severe noise in the clip. It is left at zero by default.

Motion

These parameters control what motion you are looking for when you track:
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• Translation: The position of the object

• Scale: Whether the object gets larger or smaller

• Rotation: The angle of rotation of the object

• Shear: How the object is skewing relative to the camera

• Perspective: How the object is moving in perspective relative to the camera

• Mesh (Mocha Pro Only): Movement within the overall plane, such as distortion,

warp etc.

The main difference between shear and perspective is the relative motion. Shear

is defined as the object warping in only two corners, whereas perspective is most

often needed where the object is rotating away from the viewer significantly in

space.

As an example, if someone is walking towards you, their torso would be showing

shear as it rotates slightly back and forth from your point of view.

The front of a truck turning a corner in front of you would be showing significant

perspective change.

• Large Motion: This is the default. It searches for motion and optimizes the track

as it goes. Small Motion is also applied when you choose Large Motion.

• Small Motion: This only optimizes. You would use Small Motion if there were

very subtle changes in the movement of the object you are tracking.

• Manual Tracking: This is only necessary to use when the object you are

tracking is completely obscured or becomes untrackable. Usually used when

you need to make some adjustments to complete the rest of the automated

tracking successfully.

• Existing Planar Data (Mocha Pro Only): This is only used when you want to add

Mesh tracking to an existing planar track.

Search Area

This defines ranges for the tracker to search within

• Horizontal/Vertical: The distance of pixels in the footage to search for the next

object position. This is set to Auto by default.
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• Angle: If you have a fast rotating object, like a wheel, you can set an angle of

rotation to help the tracker to lock onto the detail correctly. The tracker will

handle a small amount of rotation, less than 10º per frame, with Angle set to

zero.

• Zoom: If you have a fast zoom, you can add a percentage value here to help

the tracker. Again, the tracker will still handle a small amount of zoom with this

set to zero.

Visualising Search Areas

If you want to see the extent of the horizontal and vertical search area, you can

turn on a matte to view the boundaries.

To turn on the search area matte:

1. Press and hold the Show Layer Mattes button in the View Controls or select

View | Mattes from the menu

2. Select Selected Search Areas from the sub-menu

3. If the matte view is not already on, click the Show Layer Mattes button to

turn on matte view.

You should now see an area around the spline that represents the extent to which

Mocha will look for the object in the next frame.


The Selected Search Area view is a visual guide only and has

no impact on track mattes or roto.

Tracking the Spline

Before performing the actual track, adjust the settings depending on the

movement in the clip.

Track the plane selected by pressing the Track Forwards button on the right-hand

side of the transport controls section.
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Stop the track and adjust the shape if it doesn’t seem to be tracking properly. You

may keyframe the spline shape so that it tracks only the planar region of a shape

by adjusting the shape and hitting Add Key in the keyframe controls menu. Keep

in mind that no initial keyframe is set until you first hit Add Key or move a point

with Auto-Key turned on.

Checking Your Track

The spline should be tracked in addition to the clip being cached to RAM. You can

play it back and get an idea as to how the track went. F

eel free to change the playback mode in the transport controls to loop or ping-

pong your track.

Another trick you can do to check your track is hit the Stabilize button in the View

Controls.

Turning on Stabilize will lock the tracked item in place, moving the image to

compensate. In the track module, stabilize view is a preview mode to check your

track. Actual stabilization output is handled by the Stabilize Module, explained in

the Stabilize Overview chapter.

The Surface

You can check the accuracy of your planar track by turning on the Surface (the

dark blue rectangle) and Grid overlay in the Essentials panel or the toolbar:

• Drag the inner corners of the Surface to match the perspective of your tracked

plane.

• Drag the edges of the Surface to adjust them along the matched perspective

• Drag the points in the middle of the edges to scale horizontally or vertically

• Click and drag the outer corners to rotate the Surface
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• Hold SHIFT and drag a corner to scale uniformly.

If you play the clip, you should see the surface or grid line up perfectly with the

plane you tracked.



The Surface and Grid have no keyframes; they are simply guides

that let you check the accuracy of your track. Note that the

position of the Surface WILL affect the exported tracking data, so

you MUST position the corners of the Surface before exporting

tracking data.

Click on the Surface button in the Essentials panel or the toolbar.

When you turn on the surface you will see the blue box that represents the 4

points of the corner-pin. Right now you will see that it is not lined up with the

screen.
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As described above, by selecting each corner one at a time you can adjust the

surface area to cover the area of the screen,

or you can use the middle points to scale and the outer corners to rotate.
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The Grid overlay should line up with the plane you’re tracking and move with it as

you cycle through the clip.

You can change the density and scale of the grid by adjusting the values in View |

Viewer Preferences:

The grid overlay can give you a quick representation of the accuracy of the track.
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The Trace feature allows you to see the position of the planar corners over time.

Skip allows you to work with only every nth frame, useful on particularly long roto

shots where the movement is predictable.
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

When you track a layer, the mattes of any active layers above the

layer itself are subtracted from the matte of the layer and hence

influence the area being tracked. To keep your tracking

predictable, it is recommended that you keep your tracking layers

on the top of the stack unless you specifically wish to use other

layers to subtract from the tracking area of layers beneath it.

To monitor what the tracker "sees" as a tracking area, select the Track Matte

button in the view control.

The Surface Right-Click Menu

You can modify aspects of the surface by right-clicking anywhere on the edges or

the centre point.
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• Set Ratio: This submenu allows setting of predefined ratios or custom ratios:

◦ Source: Sets the current surface to the same ratio as the source footage

◦ Insert: Sets the current surface to the same ratio as the insert clip

◦ 16:9, 4:3, 2:1: Sets the surface to these commonly used ratio types

◦ Custom…: This brings up an entry field so you can define your own ratio,

either in dot format (e.g 1.4) or colon format (eg. 16:9)

◦ Swap: Swaps the width and height of the surface.

• Align: This is the same control as the Align Surface tool button in the Toolbar. It

will set the size of the surface to fit the dimensions of the tracked footage.

• Hide: Hides the surface. To turn it back on you will need to toggle the view

from the toolbar.

• Reset: Resets the surface back to the dimensions of the spline area. If more

than one spline exists in the layer, it will reset to the collective area of all

splines.

• Hide Insert: Hides the insert clip inside the Surface without turning off Preview.

Toggle to turn the insert back on.


Changing ratios is performed on the currently distorted state, so

will be set as close to the correct ratio as possible.

Redoing or Deleting Tracking Keyframes

If you want to start a section of tracking from scratch, you can just re-track the

area without clearing keyframes.
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However if you’d prefer to delete keyframes you have multiple methods.

Clear from the Timeline

You can use the clearing buttons on the righthand side of the timeline to delete

keyframes as a batch.

Delete All Keyframes: Deletes all

keyframes on the timeline for the

selected layer

Delete All Forward Keyframes: Deletes

all keyframes on the timeline forward

from the playhead for the selected layer

Delete All Backward Keyframes: Deletes

all keyframes on the timeline backward

from the playhead for the selected layer

All keyframes on the Mocha timeline are contextual, i.e. what you select in Mocha

updates the timeline to show the keyframes for that selection.

For example, if you have a spline selected, Mocha will show the spline keyframes.

If you select a keyframable parameter, it will show those keyframes and so on.

For tracking, the keys are hidden unless you expose them using the Manual radio

button in the Motion section of the tracking parameters.

To correctly delete tracking keyframes this way:

1. Click on the Manual radio button in the Motion section of the track parameters

2. Position your playhead where you want to clear the keys (If you are clearing all

keys you don’t need to do this)

3. Click the corresponding delete button to clear tracking keyframes

4. Click the Large Motion radio button to take the tracking out of Manual mode

again.


If you don’t want to make a keyframe for the Motion selection, turn

on the Uberey button before you switch modes.
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Clear from the Dopesheet

The alternative method for clearing keys is to open the dopedheet and delete the

keys from there.

To correctly delete tracking keyframes this way:

1. Switch to the Dopesheet

2. Locate the layer you want to clear keys from

3. Twirl down the Layer tree

4. Twirl Down the Track section

5. Select all group level keys (these are the hollow keys) of the track section you

want to delete

6. Press the delete key

You will see the blue section of the keys you deleted clear in the timeline.

Importing Mattes

 This feature is only available in Mocha Pro

There may be instances where you have already created mattes for one or more

objects in the shot, for example using a keyer or another roto tool that would help

you isolate areas to track.

You can import such mattes by creating a new layer and then using the Matte Clip

setting under Layer Properties to assign it to the layer.

Merging Tracks

 This feature is only available in Mocha Pro

Sometimes when you’re dealing with a difficult shot it’s easier to break the

tracking into multiple layers.

If you want to combine these tracks together you can do so with the Merge

Layer Tracks option.
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Merge Layer Tracks appears as a button under the layer controls, but is also

available as a menu option under the Edit menu and the Actions menu.

Track merging creates a new layer with the merged keys.

This happens in a top-to-bottom priority, meaning that tracking keys in the

topmost layer of the selection will always be copied,

then the next layer will merge any keys that should fill gaps missing from the

previous layer and so on until all layers are merged.


Merging a combination of layers that have gaps in the tracking data

may produce unstable results.

To use Merge tracks:

1. Select the layers you want to merge. The layer tracks should be on areas with

similar planar movement, especially if merging perspective or shear tracks.

2. Click the Merge Layer Tracks button in layer controls

A new layer will then be created with the combined layers.

Tips for Tracking

Scrub your timeline

When starting a new project, go through your footage a few times to see what

your best options are for tracking. You will save yourself a lot of time by making

note of obstructions and possible problem areas in advance.

Use edges

When tracking surfaces you will usually get a much better track if you include the

edges and not just the interior of an object. This is because Mocha can define the

difference between the background and the foreground and lock on better.

For example, if you are tracking a greenscreen, it is better to draw your shape

around the entire screen rather than just the internal tracking markers. In some

cases this means you can avoid tracking markers altogether and save time on

cleanup later.
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When in doubt, ramp up your pixels

You can quite often get a great result with default settings, but if you’re getting a

lot of drift, try setting the Min % Pixels Used value higher. The processing can be

slower, but you will usually get a much more solid track.

Draw more shapes

Remember you are not limited to one shape in a layer. Use a combination of

shapes to add further areas or cut holes in existing areas to maximize your search.

If necessary, make an additional layer to track and mask out foreground

obstructions before tracking the object you need.

Use the grid while tracking

It’s common to use the surface and the grid to line up your corners after you track,

but it can be much more advantageous to set up your surface before you track

and leave the grid on to watch for any subtle drift while you are tracking. This way

you can stop your track early to fix any issues and spend less time trying to find

them later.

Track from the largest, clearest point

In order for Mocha to keep the best possible track, it is usually best to scrub

through the timeline and find the largest and clearest area to begin tracking from,

draw your shape there, then use backwards and forward tracking from that point.

For example, if you have a shot of sign coming toward you down a freeway, it is

usually better to start at the end of the clip where the sign is largest, draw your

shape and track backwards, rather than start from the beginning of the clip.

A planar surface does not necessarily have to be flat

We have a Planar Tracker which specifically tracks planes of motion, but this is

not limited to tables, walls and other flat objects.

Distant background is considered flat by the camera where there is no parallax.

Faces can be tracked very successfully around the eyes and bridge of the nose.

Rocky ground, rumpled cushions, clumps of bushes, human torsos and curved car

bodies are all good candidates. The key is low parallax or no obvious moving
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depth.

When in doubt, try quickly tracking an area to see if it will work, as you can quite

often trick the planar tracker into thinking something is planar.

In the end, there is no magic bullet

Mocha is a very flexible tracker and will save a lot of time, but you will eventually

run into a piece of footage that just will not track. Large or continuous

obstructions, extreme blur, low contrast details and sudden flashes can all cause

drift or untrackable situations.

If something just isn’t tracking no matter what you try, consider using Mocha to

track as much as possible then move to manual work. You can often get a lot

more done fixing shots by hand or using AdjustTrack in Mocha rather than trying

to tweak your shapes and parameters over and over again to get everything done

automatically.
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AdjustTrack

Overview

There will be times when tracks can drift due to lack of detail or introduction of

small obstructions.  When this occurs, manual refinements can be made by using

the AdjustTrack tool.

AdjustTrack is primarily used for eradicating drift by adjusting reference points to

generate keyframable data to compensate.  It is generally not practical to use it to

remove jitter.

To achieve an adjusted track you would ideally line up the surface area where you

want to place your insert or lock down your roto.

In situations where you don’t require an insertion you could place the corners of

the surface area in distinctive locations.

The Transform AdjustTrack is designed to be an easier user experience from the

Classic AdjustTrack (see below) by removing the need to use the surface as your

alignment tool.

In Transform AdjustTrack you can adjust based on specific transforms with as

many reference points as you require over time.

Setting up reference points

You can set reference points either as a template for the kind of adjustment you

want, or add them yourself as needed.

 We recommend turning off the splines view (i.e 'Show Layer
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Outlines') during adjusting the track so you can see the adjustment

of points clearly.

Transform Type

The transform type is used to set up the method of Adjustment you want to use

for the shot.

Each checkbox sets a different number of points when you click “Set Points”

• Translation: Sets one point for x/y translation

• Scale/Rotation: Sets two points to rotate or scale between points. Moving a

point toward or away from the other point scales, moving a point at an angle

the other causes rotation.

• Shear: Sets 3 points for allowing skew/shear adjustment

• Perspective: Sets 4 points for full 4-point corner-pin style perspective

adjustment.

Note that the Transform selection works in a similar way to the Motion type in the

Track module. When you select a motion type further down the list, it will

automatically select the ones above it in order for the tracking keyframes to be

adjusted predictably.

You can opt to turn off the default-selected transform types later if you need to

do a specific adjustment.

After you have chosen the type, click 'Set points' to create the points. You can

then adjust the reference points (see below).
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Reference Points

1. You can add more points to your adjustment as required. Each point

contributes to the adjustment of the plane based on the position of the other

points.

2. You can select between the points using the cursor or cycle using the select

<> buttons.

3. Position your points on easily identifiable areas

4. Once you are happy with the position of the points, click “Set Reference

Frame” to define a frame to look to when adjusting forwards or backwards

from that point.
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Adjusting points

Once you are happy with the points positions and have set a reference frame, you

can start moving back and forth on the timeline adjusting the points for drift.

Right-clicking a point selects all points or you can shift-click individual points and

can move them as one.

Take note of the Transform type when moving points, as the Transform type

affects how points adjust the track.

By default, for your initial set of points, each point adjustment sets a key frame for

every other point in the shot to avoid unwanted distortions.
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You can see the original reference frame for the selected point in the zoom

window in the upper left of the viewer and the current frame in the window below

that.


An adjustment point only affects the track within the bounds of its

own keyframes. Outside that keyframe range it stops adjusting the

track. See Adjustment Point Lifespan

You can then keep adjusting the points over the timeline until all drift is corrected.

Point Arrows and Keyframe Direction

You’ll notice as you make keyframes for your points that they have different arrow

symbols in the viewer. These help you determine what points have been

keyframed and if there are other keyframes in the timeline for that point.

If there are point keyframes to the left, right or both sides of the current frame,

arrows will appear to indicate the direction they are in.

Here’s what these symbols mean:

Reference Point: An initially placed reference frame

point with no adjustment keyframes.
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Reference Point with Keyframes: A reference frame

that has adjustment keyframes. Arrows will point in

the direction keyframing has been done on the

timeline. If there are keyframes on either side of the

reference frame, there will be arrows on both sides.

Keyframed Point: A point that has been keyframed.

The bracket arrow indicates the keyframing. Closed

triangle arrows point in the direction of other

keyframes that exist on the timeline for this point.

Non-Keyframed Point: A point that has not been

keyframed on this frame. The non-bracketed triangle

arrows will point to other keyframes for this point on

the timeline.

Adding New Points for Further Adjustment

It’s quite common that one of your AdjustTrack points is going to get obscured, go

out of frame or no longer have a usable visual reference in the scene.

This is when you may want to add new points to the adjustment.

You can add as many points as you like to an adjustment over time. Each

keyframed point contributes to the adjustment on that frame.

In order to do this effectively however, you need to understand AdjustTrack

Transform keyframe ranges.

Adjustment Point Lifespan

Each point in AdjustTrack Transform has what is known as an effective keyframe

range. This is the lifespan of the point currently in use.

A point can be moved to contribute to the current adjustment, but that point’s

adjustments are only valid between those keyframes.

Any additional keyframes you add to a point further in time forward or backward
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from the reference point will contribute to the overall adjustment.

Points do not contribute to an adjustment outside of their keyframe range.

What this means is you can add new points further along the timeline that can

create adjustments that won’t be affected by the other points.

Example 1. AdjustTrack Keyframe Range

The point below has a reference point at frame 571 and an adjustment

keyframe at 610. This point only affects the track adjustment between these

keyframes:

Also note the extra bracket on the arrow on the adjustment point. This tells us

we’re currently in the contributing keyframe range of the point.

Creating a New Point as a Replacement Reference

Sometimes a point can no longer contribute to the adjustment.

When you want to add a new point to continue the adjustment, you can create

one at the keyframed boundaries of the old point:

1. Go to a frame in the timeline that is on or outside the keyframe range of the

point you are no longer using.

2. Click "Add New Point" to toggle on the new point tool
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3. Place the new point at a clear feature location. It will then become a new

starting reference point.

4. Click "Add New Point" again to toggle it off

5. You will will then want to keyframe points separately to avoid keyframing the

old point. See "Keyframing with a New Point" below.

Keyframing with a New Point

By default, all AdjustTrack points are keyframed at the same time with the

"Keyframe All Points" option:

When adjusting new points in a different keyframe range you will want to turn off

"Keyframe All Points" or use the Alt+CMD/Ctrl shortcut when altering points.

This is important, because continuing to keyframe all points will make the old

points still affect the adjustment at that frame in the timeline.

After creating your new point:

1. Move to a new position in the timeline where there is drift

2. Turn off "Keyframe All Points" (Or hold down Alt+CMD/Ctrl)

3. Adjust the new point
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4. Repeat for any points still contributing to the adjustment

5. Do NOT keyframe the old point. Keyframing an obscured or out of frame point

will re-add its position to the adjustment

We recommend locking points when you are no longer using it in the current

adjustment range. See Locking Points below.


Keyframing Adjustment points will cause them contribute the

adjustment in that keyframe range. Keep this in mind when going

back to older points.

Example 2. Adding and adjusting new points

In this example, the point in the bottom corner is about to go off screen. It’s

last adjustment keyframe is on frame 276:

We can create a new reference point at this frame to keep adjusting when the

old point goes offscreen. Note that this is on the same frame (276):
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Further along the timeline, the old point is now out of the screen, but we can

keyframe the new reference point, making sure we’ve turned off "Keyframe All

Points":

We then adjust any other point we still want to contribute to the adjustment,

adding a keyframe for those points. Note the specific keyframing arrow that

tells us it’s contributing.
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Selecting the old point that is outside the view, we can see it doesn’t have a

keyframe on this frame, and so it is not in the adjustment range:

Locking Points

To avoid keyframing reference points by accident, you can lock a point by using

the lock icon in the interface:
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When a keyframe is locked, it turns grey in the viewer. It can still be selected, but

you can no longer keyframe or move the point until you unlock it again.

To unlock a point, just select it and click the lock icon again.

Surface View
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While you are adjusting, you can click one of the “Surface View” corners to see

how the surface itself is adjusting to your changes. This is helpful if you are

ultimately planning on using the surface as your export area and want to make

sure it is still lining up.

Nudge

Nudging is used to adjust the track by pixel increments. This helps when

adjustments are too subtle to be done by mouse movement.

Each arrow nudges in the indicated direction. You can either click and hold the

button or use the shortcut keys to nudge.

The 'Auto' button in the middle of the direction grid tries to guess where the point

needs to be.

It can be useful to start with 'Auto' to attempt to place the reference point first,

then adjust manually.
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Auto Nudge

Auto Nudge takes the 'Auto' action above and lets you use it space adjustments

over the whole shot.

If you set 'Auto Step' and define a frame step you can then 'Track' the Auto Nudge

using the tracking buttons in the timeline. Auto Nudge will then nudge the

selected reference points at the frame step interval set.

The Search fields define how far Auto and Auto Nudge look for the area the point

needs to adjust to.


Auto Nudge is useful for quickly going through a shot to help pace

adjustments. It is not recommended to be used as a solution for

finishing adjustments.

Exporting

You can export adjusted tracks as normal via the file menu or via the Track

module just like any regular track.

AdjustTrack Classic
We’ve kept the old-style of AdjustTrack for those who prefer to it, or if you are
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working with legacy projects.

This version of AdjustTrack is primarily used for eradicating drift by utilizing the

four-corner surface area to generate keyframable data to compensate.  It is

generally not practical to use it to remove jitter.

Starting the Track Adjustment

When you have the Surface where you want it to stay locked and are ready to

refine the track, flip over into the AdjustTrack module by hitting the AdjustTrack

tab.

Then switch to the Classic tab.

Reference Points

Once you select the Classic AdjustTrack tab, a key frame with four reference

points is created.



You should be on your desired primary frame before selecting the

AdjustTrack tab. The reference points can then be positioned on

distinctive features, such that any drift in the track can be easily

seen and corrected.
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As you play though the sequence you will be able to manually adjust the position

of each point as drift occurs.

If your track is spot on, these reference points should line up properly throughout

the shot. If you see a Reference Point drifting, that will indicate the track is

drifting. Find the frame where the drift is worst and move the Reference Point

back to the position it had in the Primary Frame and the track will automatically be

adjusted based on your correction.

Reference Point Quality

When you perform an adjust track and you begin to move a newly created

reference point, you will notice the dashed lines which connect all of the reference

points. These lines change in color to represent the quality of positioning of any
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given reference point. For best results keep reference points away from one

another.

When adjusting the track try to always get at least yellow but shoot for green for a

more solid adjust track.

The red lines indicate that this reference point position is a poor choice.
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The green lines indicate that this reference point position is a good choice.
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AdjustTrack with More than Four Reference Points

Often there are times where your reference points are either obscured or exit

frame. In AdjustTrack you have the ability to create multiple reference points per

surface corner that can be positioned in alternate locations to handle these

situations. Simply click the New Ref button to create a new reference point for the

selected corner.

You cannot keyframe the Surface — only the Reference Points. The original track

and any refinements you make in AdjustTrack cause the Surface to move

however.
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Working Backwards

Every so often a shot will come along that is easier to track backwards than

forwards. This is fairly simple when running the tracker backwards, but introduces

some rather obtuse concepts when keyframing is involved. This is why there are

two "New Ref" buttons provided. If you are working backwards and wish to set a

new reference point, you will probably want to use the "<- New Ref" button

instead of the forward-thinking "New Ref ->" button.

Because keyframing "thinks" forward, hitting "<-New Ref" will not create new

Primary Reference points on the current frame, but will go backwards in time,

looking for any existing keyframes and set new Primary Reference points on the

frame directly after. For example, if you decide to create a new backwards

reference point at frame 20, a new primary reference will be created at frame 21.

Some people may be more comfortable doing this manually by moving the

playhead themselves and using the traditional "New Ref ->" button. Others who

do a lot of tracking and find themselves working backwards often may find the

backwards-thinking New Ref button helpful.

About Primary Reference Points (the red X)

Every Reference Point has one frame in which its initial placement is determined

without causing any adjustment to the track. This is called the Primary Reference

Point; if you step forward or backward in time you will notice the red X change to

a red dot.
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The red X indicates that this particular frame is the starting point for calculating

adjustments. Moving a Primary Reference Point will NOT change the tracking data.

Go ahead and experiment - move the Reference Point when it is a red X (a Primary

Reference Point). You will notice the Surface isn’t adjusted at all. Step forward a

frame and move the same point - this time the surface will move because you are

now adjusting the track.

Changing the Primary Frame for a Reference Point

By default, the frame in which you create a Reference Point is its Primary

Reference frame. This Primary Reference can occur on a different frame for each

reference point. You can change the Primary Reference frame by selecting a

Reference Point, going to the appropriate frame and hitting the "Set Primary"

button.
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You may set a new Primary Reference Frame for all active points by hitting the Set

Primary All button.

Selecting Different Reference Points

One method for selecting different reference points is to hit the "Next" button.

The next button simply cycles through the active reference points for that frame.

More fine-grained control of reference points can be obtained through the Nudge

control panel, described below.

Deleting Reference Points

Deleting Reference Points is done by selecting the point you wish to remove and

hitting the delete key. If there are multiple Reference points on a particular corner,

the preceding Reference Point will be extended through your time line until a new
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Reference point is encountered.

Nudging Reference Points

The Nudge section allows you to move Reference points in 0.1 pixel increments,

much more fine grained than would be possible by dragging the points manually.

You can easily select any active Reference Point by selecting one of the corner

buttons in the Nudge section.

If you hit the Auto button, a tracker will attempt to line up the selected Reference

Point based on its position in the Primary Reference frame. The Search Region

Size and Maximum Motion parameters can be set in pixels in the Auto Nudge

section.

You can quickly select any corner by using the Corner selector buttons in the

Nudge control panel. In the image below, the user is selecting the upper right

corner in preparation for nudging operations.

View Options

The Classic AdjustTrack tab has a View section for cleaning up your AdjustTrack

workspace. Deselecting the Inactive Traces button will cause the display to hide

the traces of the inactive Reference Points. This is helpful if you have a corner

with numerous Reference Points offsetting it.

Deselecting the Unselected Traces button will hide any Reference Point that is not

selected.

Finally, deselecting the Search Area button will hide the Search Region Size (in

Yellow) and the Maximum Motion search area (in Pink).
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Tips for AdjustTrack

Adjust frames at the peak of drift

When you see a drift, carefully cycle through the timeline and look for where the

motion starts to change direction. A frame before this, adjust your drift, then go

halfway between your primary frame and the adjusted frame to check for any

further drift.  If you keep working by checking halfway between each keyframe

you set, you will reduce the amount of keyframes required.

A huge amount of keyframes is not a good sign

If you end up with adjustment keyframes on a large amount of frames it may be

better retry the track.  AdjustTrack is aimed to help reduce small anomalies and fix

drift when a tracked corner has become obscured.  If you are fixing every second

keyframe it means you have more than a simple drift.
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Rotoscoping Basics



Some tools, parameters and techniques listed below may not be

visible in Essentials mode. To see additional interface elements,

switch to Classic mode. See the Layouts section for more

information.

The Art of Rotoscoping

Most often a good matte requires a combination of both keying and rotoscoping

techniques.

Good rotoscoping artists often think like animators, reverse engineering the

movements, the easing in and outs, the holds and overshoots of objects, and set

their keyframes accordingly.

In general, the fewer the keyframes, the better your mattes will look. Too many

keyframes will cause the edges to 'chatter' and move unnaturally. Too few

keyframes will cause the shapes to drift and lose definition. Finding the right

number and placement of keyframes often comes with experience but there are a

few things to keep in mind when rotoscoping.

Traditional Roto Tips

1. There is no such thing as a perfect matte. Rotoscoping is an art form that takes

into account the background image, the movement of the object, and the new

elements to be composited in the background.

2. Try to start your shape at its most complex point in time, where it will need the

most control points.

3. Break a complex shape into multiple simple shapes. If you are rotoscoping a

humanoid form and an arm becomes visible, consider rotoscoping the arm as

its own element, rather than adding extra points on the body that will serve no

purpose when the arm is obscured.

4. Imagine you are the animator who created the shot. What would your dope

sheet look like? No matter the medium, whether CG, live action or otherwise,

most movements are rarely linear. They normally move in arcs; they normally
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accelerate in and out of stopped positions. Try and understand the mechanics

behind how things are moving in your shot. This will help you to minimize

keyframes.

5. Watch and study the shot before you start working. Where are the changes in

directions? These will normally have keyframes. Where are the starts and

stops? Are there camera moves that can be stabilized to make your work

easier?

6. Don’t be afraid to trash your work and start over. Beginning roto artists often

make the mistake of trying to fix a flawed approach by adding more and more

keyframes. Experienced roto artists learn to quickly identify an inferior

approach and are unashamed to trash their work and start over, often many,

many times. It is very difficult to get a good matte without a conscious effort to

keep the keyframes to a minimum.

Mocha Tracking and Roto

While you can refine a shape you have tracked to do your rotoscoping, the

recommended way is to do a rough shape to track something and then link your

roto to that track. This reduces the amount of work required when you are dealing

with complex shapes, as you will not have to track and refine each shape as you

go. It also means that if you have to retrack something you won’t have to redo a

lot of layers. Another reason is reducing the amount of data needed in your

project file.

It also helps to remember that your spline shape is linked to your tracking data

and not the other way around.

For the following examples you can try out the tools using the BMW tutorial files

available from https://cdn.borisfx.com/borisfx/store/mocha-clips/rotoscoping.zip

Quick Shapes - Rectangle and Ellipse

You can use the Shape tools to quickly draw around objects in your view:

• Rectangle: Select the tool and draw to size, or double-click to automatically

create a Rectangle.

• Ellipse: Select the tool and draw to size, or double-click to automatically create
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an Ellipse.

Holding the Shift key and double-clicking will make a uniform shape. In the case of

Rectangles it will make a square, and for Ellipses a circle.

Rotoscoping Workflow

1. Track the area you want to rotoscope

First of all you want to reduce as much manual work as possible by tracking. In the

example below, the front and side plane of the car is being tracked (For a more

detailed coverage of tracking, see the Tracking Basics documentation).

2. Turn off your tracking shape

Once you’ve tracked an area it can be useful to turn it’s visibility off, as well as it’s

tracking cog (so it can’t be accidentally retracked later). This means the tracked

shape will not be confused with any roto shapes you are making.

3. Start drawing your refined shapes

Once you have a track for a layer we recommend that you add a new layer to use

for the actual roto spline, rather than refining the spline you used for the actual

track as you might need to do more tracking with it later.
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Select the X spline or Bézier spline tool and draw a tight spline around the object

you are rotoscoping. Ctrl/Cmd+drag the Bézier tangents if you wish to break

them. You will see that a new layer is automatically created.

4. Link the new roto layer to your tracked layer

You don’t want to track with this layer, so disable tracking for the layer by turning

off the tracking button (the cog) for the layer in the Layer Properties panel.

Rename the new layer and link it to the movement of your already tracked layer by

selecting it from the 'Link to Track' dropdown in the layer properties panel.

Your newly created roto spline will now follow the motion of the linked track.
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5. Refine your roto

Now you have linked the rotoscoping layer to a track, you need to go over the

timeline and make sure the roto is correctly animated.

Often you will need to tweak your shape for it to fit correctly, adding new

keyframes. Autokey is on by default, so you just need to move along the timeline

and adjust your points where necessary (keyframes turn up in the timeline as

green dots). The tracking data will help for the majority of the motion.

You can also add additional shapes to the same layer using one of the "Add Spline

to Layer" tools. These are the drawing icons with the plus sign next to them ("+").

You can cycle between each point on a spline with the keyboard shortcuts '{' and

'}'. This is useful for when you need to do minor adjustments across many points

separately.

6. Feather your edges if necessary

Edges can be feathered either by dragging out feathers point by point using the

edge pointer tools in the toolbar or by using the parameters in the Edge Properties

panel.

In the toolbar you have four different pointer tools:

• The pointer tool with the 'B' will move both the inner and outer spline point (‘B'

= ‘Both')

• The 'I' pointer will only move the inner spline
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• The 'E' pointer will only move the outer spline point (‘E' = ‘Edge'). A feathered

edge will occur between the inner and outer spline points

• The 'A' pointer will remove either the inner or outer point depending on which

is selected (‘A' = ‘Any')

You can also use the Edge Properties to feather the edge at the selected point(s)

an exact amount or use the Add button to increase/decrease the feather by the

specified amount.

The Edge Offset buttons cover three different approaches to manipulating the

edges:

• Outer Edge (Default): Moves the outer edge feather in and out. You can also

set this to a specific pixel width. This will not reduce below zero to avoid

inverted feathering.

• Inner Edge: Moves the inner edge up to the outer edge or towards the centre

of the spline.

• Both: Scales both the inner and out edge inward or outward. This is useful for

tightening up a matte or expanding edges for garbage mattes.

For example, if you deselect all points by clicking anywhere on the canvas you can

then use the Set button to apply the default 3 pixel edge width.

Because no points are selected the value is applied to all points on the current

layer.

You can then tweak the position of all spline points to ensure that the inner (red)

spline is inside the edge and the outer (blue) spline is outside the edge.

7. Track additional sections as you go

In many instances one track will not be enough. You may need to track more than

one plane to drive different sets of roto. In the car example, we have to track the

front and the side to get an accurate track for each planar region to assist the roto
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effectively.

In the case of organic shapes, like people, you will have to break your tracks down

to handle the different movement between the torso and the arms etc.

What’s the Überkey?

The Überkey is a powerful tool that allows you to offset the positions of control

points without destroying their keyframe data.

Use this tool with care, as it is not setting any keyframes per se, it is offsetting any

and all keyframe data on the points you move while it is on. Überkey is very

useful, but remember to turn it off again when you don’t need it. Use with care.

Überkey affects only those frames between the timeline’s In and Out point. If you

wish to make adjustments to a particular range, set the In and Out points to that

range.

Translate, Rotate and Scale your Splines

You can translate, rotate and scale selected points as a group by using the

corresponding tools listed in the toolbar.

Or alternatively, use the transform tool to perform all of the above functions in the

same tool:
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Turning On and Off Points

You can turn on and off individual points in a spline. When they are off, you can

still see the points, they can still be animated, but they are not contributing

mathematically to the spline. This allows you to have a complex spline only when

you need it, rather than having to deal with superfluous points in parts of the shot

when they are not needed.

To turn off points, select the points on the spline and hit Shift+Delete. You will see

the curve change shapes, but the points will remain.

To turn a point back on, right-click on it and select Point | Activate.

If the Autokey button is enabled, a keyframe will be created when you change a

point’s active status.
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Add Motion Blur [Mocha Pro Only]

You can use the movement of the individual spline points to determine motion

blur.

Any movement in the spline, whether through simple X/Y translation or by shape

deformation will cause motion blur.

You can control the amount of blur by changing the motion blur value in the Edge

Properties panel.

Angle

This essentially controls the amount of motion blur for the layer.

Angle simulates how long the shutter is open for if we were viewing through a real

camera, so the range is between:

• 0 (closed, which means no motion blur)

• 360 (fully open and therefore the maximum motion blur possible).

The reason we refer to angle as opposed to "amount" is that camera shutters

used to open with a rotary action, so a smaller angle would let in less light, and

thus reduce motion blur.

Phase

This controls the offset of the motion blur from the current frame.

Changing Phase from zero shifts the position of the motion blur to either be more

ahead or behind the currently calculated frame and is useful for tweaking motion

blur that isn’t quite sitting right.
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Because Phase is based on the shutter angle you can adjust between the range

-180 and 180 (i.e a range of 360 like the shutter angle).

Quality

The steps of motion blur you want to render. The lower the quality, the faster the

render speed. The default is 0.25 but can go as high as 5.0.

Changing the Matte Blend Mode

Although not necessary in this example, note that you can change how mattes are

blended in the Layer Properties panel. You may make each layer’s matte Add or

Subtract and you can also invert the matte.

Note that this can’t be keyframed and that these settings apply to the entire layer,

not to individual splines of the same layer.

Viewing your Mattes

In the View Controls, several options are offered for viewing your mattes. The

Matte drop down is has options to view all mattes, just the mattes you have

selected or no mattes.
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Select the Matte button and you will see your rotoscoped object against a flat

background.

Changing the Background Color

You may wish to rotoscope against a particular color. Select View → Canvas

Color… and a color picker will allow you to choose a particular background color
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Colorize your Matte Overlay

When you have your Mattes turned on, you may choose for the matte to be filled

with a color instead of cutting out the object, using Colorize.

You can adjust the opacity of the color fill by changing the blend value to the right

of the Colorize button.

The color used by Colorize is derived from the Selected and Unselected

properties of the Overlay Colors panel, which can be changed per layer.

This is only a preview and will not affect how your mattes are rendered when

exporting.

Hiding splines or points

If you want to get a better view of your roto, you can get a better view by turning

off some overlays.

For layer spines:

1. Select your layer and turn on the Mattes button (Show Layer Mattes)

2. Uncheck the Splines option in the 'Show Spline Tangents' dropdown

For points:
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1. Right-click the spline

2. Choose Layer > Hide points

Hiding points will still allow you to adjust the layer with the transform tool.

Preview Rendered Mattes [Mocha Pro Only]

In the View Controls panel, you will find a drop-down menu for selecting the clip

to view.

This allows you to view the actual rendered mattes, which can be especially useful

when tweaking motion blur. The motion blur you normally see in your canvas is an

OpenGL preview and can differ slightly from the actual render.

If you’d like to see what the actual motion blur render looks like, switch to viewing

the layer whose matte you wish to see.

Because you can choose specific layers for export when you render, a render

pass is created for each layer.
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Switch the View Clip drop-down back to your source clip to continue working with

that clip.

Open Splines

If you want to draw open splines, you can simply hold shift when you right-click to

finish the spline. This will open the shape up.

Existing shapes can also be made open or closed:

• You can open an existing shape using the Open Spline shortcut key (by default

this is 'o')

• You can close an existing shape using the Close Spline shortcut key (by default

this is 'c')

• Both the Open and Close shortcuts also work for finishing a spline rather than

using Shift + Right-Click

You can also right-click a spline and choose: Spline | Open/Close Spline

Using Falloff for Adjusting Larger Clusters of Points

 This feature is only available in Mocha Pro

Normally adjusting points is done by moving selections of points or carefully

moving individual ones.

An alternative approach is to use the falloff tool to move contiguous points in a

spline all at once with a gradient of strength.
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With the selection tool active, you can click the falloff icon to activate the

selection radius.

This is adjustable via a field in the Falloff panel:

• Radius: Adjusts the size of the affected area

• Strength Adjusts the strength of the falloff. At 100% all points within the radius

are moved the same amount as the selected point.

You can use Ctrl/CMD and Left-Dragging to adjust the size of the Radius.

Similarly, you can adjust the strength by holding Ctrl/CMD+Shift and Left-

Dragging.

Adjustments are visualised by a red gradient, but this turns off while using the tool

on points.

Any point on the line of control points near your selection that fall under the circle

will be affected.


The falloff tool doesn’t affect non-contiguous points, meaning

nearby contours or loops will not be affected when adjusting.

Splitting Contours into Different Layers

 This feature is only available in Mocha Pro
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Sometimes when you’re working on a complicated roto, you realise you really

needed a few smaller shapes rather than one big one.

To remedy this, you can split any selected points into a new layer and they will

retain the existing keyframes and tracking data.

To split a contour:

1. Select the points you want to split off

2. Go to the Edit menu and select Split Contour

The shape should now be split at the point you selected.

A few caveats:

• You can’t split off a shape using less than three points

• Similarly, you can’t split off a shape if the original shape will be left with less

than three points

• You can’t split from more than one contour at a time. If you want to split

multiple contours, just repeat the process for several selections.


When splitting contours, PowerMesh tracking is retained across the

entire area. This is to maintain any spline warping that may be lost

if you deleted the mesh to just the spline boundaries.

Snapshot Duplicates

 This feature is only available in Mocha Pro

Some roto requires making copies of existing splines to continue a different part

of the work.

To make this easier, you can use Snapshot Duplicate to make an exact in-

place copy, which compiles both the keyframed position and tracked position into

a new untracked layer.

This will also keep the surface in the exact same spot for that frame to make it

easier to match corner pins or inserts.
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To snapshot a layer:

1. Select the layer you want to duplicate

2. Go to the frame you want to snapshot

3. Under the Edit menu, choose Snapshot Layer at Current Frame

A new layer will be created that exactly matches the position of the original layer

without any of the animation or tracking keys.

You can of course just copy splines or duplicate layers normally, but with these

methods you’re often left with more work to do to remove keyframes or readjust

splines into position.

Tips for Rotoscoping

Name your layers

Naming layers is very important to save yourself time later, especially if you are

doing a heavy rotoscoping job. Get into the habit of labeling each layer with

specific names.

Turn off the splines and just work with points and the matte

If you are working on a tight roto it can sometimes be easier to turn the spline off

and just see the matte with the control points. To do this:

1. Select your layer and turn on the Mattes button (Show Layer Mattes)

2. Uncheck the Splines option in the 'Show Spline Tangents' dropdown

If your other view options are at default settings you should now see the matte in

the viewer with only the tangents and control points visible.
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The Dope Sheet and Curve Editor

The Dope Sheet

The Dope Sheet is used to move, copy and paste keyframes in your layers.

Navigating the Dope Sheet

You can navigate the Dope Sheet space by using the scroll bars horizontally and

vertically.

Holding CTRL/CMD+Scrolling the mouse wheel will let you scale up and down the

timeline.

You can also zoom to specific ranges by selecting one of the options from the

"View" drop down at the top of the dopesheet view:

Group Keyframes vs Parameter Keyframes

As you create animation or tracking data, you will see a number of hollow
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keyframes appear in the Dope Sheet. These are known as Group Keyframes which

are keys that contain multiple sets of Parameter Keyframes underneath them.

You can move the Group Keyframes like normal animation keyframes, but instead

of a single animation key, they will move all the keyframes underneath them.

This is useful when you need to shift a whole section of animation in a layer, and

not just an individual point or parameter.

Expanding a section of the layer tree in the dope sheet will reveal either

Parameter Keyframes or more Group Keyframes, depending on how many levels in

that layer tree there are.

Hidden keyframes in groups

Some keyframes are hidden as they take up a lot of space.

An example of this is PowerMesh tracking keyframes, which are very numerous

and impractical to reveal in the dopesheet.

When a hidden keyframe exists in the timeline, the group-level keyframe will still

show, letting you know there is data that can be moved or manipulated.

Selecting and Moving Keys

To select keyframes, you either click on one of them in the Dope Sheet, or

marquee select a section. You can use SHIFT to pick multiple keys.

You can move the keyframes manually by dragging them with the mouse, or you

can use the standard Copy/Paste keys (CTRL/CMD+C, CTRL/CMD+V) to copy

keys and paste them at the current playhead position.
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NOTE: At this time you cannot copy and paste Group Keyframes, only

Parameter/Animation keyframes.

Sliding Keys

To move all keyframes in the project up or down the timeline to accomodate

frame offsets or new clip lengths, you can use "Slide Keys".

You can slide keyframes one of two ways:

1. Enter the keyframe position you want into the Slide Keys field and press enter

2. Select the "Move to playhead" button to push the keyframes to the current

playhead position.

If you need to only move some of the keyframes, just select the ones needed and

use the "Selected" radio button option before performing the slide.

The Curve Editor

The Curve Editor is used to review how the data in your animation and tracking

looks, as well as some value and frame manipulation options.

Navigating the Curve Editor

You may navigate the Curve Editor space by using the middle mouse button to

Pan and the mouse wheel to zoom. Alternately, you may pan using the ‘x' key on

the keyboard and zoom using the ‘z' key on the keyboard. When zooming with the

‘z' key, left/right mouse movements will zoom in/out horizontally and up/down

mouse movements will zoom vertically.
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Selecting and Moving Keys

To select keyframes, you must first select the curve, then the keyframes.

Keyframes of unselected curves are not selectable.

You may move the keyframes manually by dragging them with the mouse, or you

may type in a "Nudge" value at the top right of the Curve Editor.

Entering a negative value in the "Nudge Time" field and hitting the button will

move selected keyframes backwards in time by that amount every time you hit

the button. Entering a positive value in the "Nudge Value" field and hitting its

button will move selected keyframes up in value by that amount every time you hit

the button.

Changing the Interpolation of Keys

Interpolation describes the method of how values are calculated between

keyframes. It defaults to linear interpolations between keyframes but you may

wish to convert them to Bezier for easing in and out. Or if you wish them to hold

their position until the next keyframe, you may wish to select Constant as the

mode of interpolation.
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Right click on a selected keyframe and choose Interpolation->Bezier. Bezier

tangent controls will appear on your keys and you may adjust them for easing in

and out.

Changing the Extrapolation of Keys

If a keyframe is the first or last keyframe on the curve, its extrapolation can be

chosen. Extrapolation describes the method of how values are calculated "off into

space" before the first keyframe or after the last keyframe. It defaults to Constant,

which simply holds the value steady.

Choose linear extrapolation and the curve editor will continue the value on its

current slope (sometimes called Gradient Extrapolation in other applications).
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The Clip Module

General Clip View

The Clip module previews your clips in Mocha. It provide basic clip property

information.

Managing clips

You cannot manage clips in this version of Mocha. To import additional clips,

manage clip streams or handle stereo, you need Mocha Pro.

Crop Mask

You can mask down the clip to only allow Mocha to handle parts of the footage.

This is useful when you only need to track some area of the clip, or need to crop

out letter boxing.

You can either adjust the Clip mask by moving the yellow dotted line on screen, or

manually entering values into the Crop Mask parameters.

Timeline numbering

Here you can set whether you want the timeline display to be in frames or

timecode.
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OpenColorIO (OCIO) Color Management

OCIO Color Management


Some OCIO features are only available in Mocha Pro and may be

missing from Mocha AE.

Mocha has extensive color management tools based on the Open Source Color

Management framework called OpenColorIO (OCIO) .

To see more on OCIO, please visit the OCIO website: https://opencolorio.org/

A Brief Overview of Color Management

Color management in Visual Effects is very important for maintaining consistency

throughout a project.

There are numerous footage sources of varying bit depths and color spaces.

Equally, there are numerous software and hardware solutions for processing that

footage.

Industry standards (such as ACES) were put in place to make it easier to pass

footage in and out of an application without losing the color information required

to match other parts of the pipeline.

Mocha in the Color Pipeline

In order to match what is seen in the compositing or editing environment, Mocha

can match the colorspace use by the host (in a plug-in environment) or can be

configured to match the colorspace of supported software.

Since Mocha often renders out a result (be it a Matte or a render in Mocha Pro) we

need to make sure we are matching the original source Mocha is working with,

otherwise the output will not match.

Setting the Working Color Space


Mocha defaults to an OCIO configuration that matches the nuke-
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default configuration found in Nuke by The Foundry.

To set a working colorspace, you can open the Viewer Preferences, which is

located in the top right-hand corner of the viewer:

Then, choose a role from the “Working Color Space” drop down that matches your

current working space:

These options default to the Mocha OCIO config file, but may show varied options

if you are using a custom configuration file (ACES,for example).

Setting the Display View color space

To set a Display View colorspace, you can open the Viewer Preferences, which is

located in the top right-hand corner of the viewer:

Then choose a Display View type from the list in the drop down:
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Defining the Clip Color Space

To set a Clip color space, go to the Clip Module and switch to the Color Space tab.

You can then choose an option from the “Clip Color Space” drop down:

You can also convert the image Depth to float or 8-bit if so required:
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These options default to the Mocha OCIO config file, but may show varied options

if you are using a custom configuration file.

Defining the Overall Project Color Space

You can define general color settings for the overall Project in the Project Settings

dialog.

This gives you all the colour settings in one place to setup the color workflow for

clips, display and working space.

To access Project Settings, go to File > Project Settings…
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Here the Color Space section is divided into several sections:

• OCIO config: Here you can change the OCIO config or reset back to the

default.
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• Working Color Space: The color space or Role you want to work with

• Display View: The color view you want to display, such as sRGB, Rec709 etc

• Clip Color space Mode: This is either OCIO or Legacy, which is important if you

are opening projects from an earlier version of Mocha.

• Default Color Spaces: Here you can define what color space to set for clips at

various bit depths.

• Depth conversion: This lets you define if you want to convert clips by default

to 8-bit or Float.

Loading OpenColorIO configurations into Mocha

Loading via the Mocha interface

You can load the path to a different config by accessing any of the config path

options in Mocha.

You can load a new config file path via:

• The Color tab in Preferences (where you can set defaults)

• The Viewer Preference dialog in the view controls

• The Project settings of a specific project

Configuration files are usually named as config.ocio in the directory of the color

standard you are working with.

Changing the color configuration will automatically update the Working Space, clip

space and Display View options.

Clicking the "Reset" button will reset your color to the Mocha default

configuration.

OCIO Environment Variable

You can define an OCIO environment variable on your system to point to a custom
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configuration.

For example, if you wanted to use the default Nuke OCIO config, you could define:

export OCIO=$HOME/OCIO/nuke-default/config.ocio

Then run Mocha (or your plugin host) from the terminal after defining this variable.

You could also set the OCIO environment variable system-wide using an

appropriate OS-specific method (e.g. the Environment Variables dialog in

Windows).

If there is no config set, you should see the Mocha default configuration in the

interface.

If you set a valid config path, you should see the complete list of supported color

spaces.

Once set, the OCIO config will be saved with the project.

Mocha Pro OCIO inside Silhouette

When using the Mocha Pro plugin inside Silhouette, you don’t generally need to

worry about setting a color space, as the plugin will try to inherit the current

working color space that Silhouette is using.

Setting Defaults for Color Space Workflow

If you’re planning on being in a particular working space for ongoing projects, you

can define defaults in Mocha Preferences under the Color tab:
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These map exactly like the controls in Project Settings, but will be assigned

automatically when creating new projects.

107



Keyboard Shortcuts

Keyboard Shortcut customization

You can now customize keyboard shortcuts for almost every tool, action and

menu item in Mocha.

You can access the keyboard shortcut customization dialog in two ways:

1. Directly, via File | Keyboard | Customize…

2. By going to Mocha Preferences and clicking the Key Shortcuts tab.

You can create a new profile by duplicating a default profile, then customize the

keys. These profiles are then available from the Keyboard menu:

Keyboard customization is very simple:

1. Duplicate one of the default profiles and rename it

2. Select a category and choose an action you want to change or add a key

sequence to

3. Click in the "Shortcut" column

4. Enter your key sequence

5. Click anywhere outside of the entry cell to complete

6. Click "Default" if you want to revert your change back to the default shortcut
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
Pressing return or delete/backspace counts as a key entry, so

please click outside the cell to complete the entry and use the

"Clear" button to clear an entry.

Default Mocha Shortcuts

Below are some of the common default shortcuts for Mocha

Tools

CTRL/CMD + F Enable Picker tool

I Toggle insert point mode on/off

Z Enable Zoom tool while pressed

X Enable Pan tool while pressed

CTRL/CMD + L Enable X spline tool

CTRL/CMD + B Enable Bezier spline tool

CTRL/CMD + Click Break Bezier handle

CTRL/CMD + Z Undo
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CTRL/CMD + SHIFT + Z Redo

C Close contour

D Delete point

Transform

W Rotate

Q Translate

E Scale

Down Arrow Nudge Point/Layer down 1 pixel

Up Arrow Nudge Point/Layer up 1 pixel

Left Arrow Nudge Point/Layer left 1 pixel

Right Arrow Nudge Point/Layer right 1 pixel

SHIFT + Down Arrow Nudge Point/Layer down 10 pixels

SHIFT + Up Arrow Nudge Point/Layer up 10 pixels

SHIFT + Left Arrow Nudge Point/Layer left 10 pixels

SHIFT + Right Arrow Nudge Point/Layer right 10 pixels

Viewer Canvas

- Zoom out

+ Zoom in

/ Zoom to 100%

* Zoom to fit

Alt + 1 Show/Hide Mattes

Alt + 2 Show/Hide Color Layer Mattes

Alt + 4 Show/Hide Layers

Alt + 5 Show/Hide Spline Tangents

Alt + 6 Show/Hide Surface

Alt + 7 Show/Hide Grid

Alt + 8 Show/Hide Zoom Windows

` (Back dash) Show/Hide All Overlays
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Timeline

Alt + Left Arrow Go to start of clip

CTRL/CMD + Left Arrow Go to previous frame

CTRL/CMD + Right Arrow Go to next frame

Alt + Right Arrow Go to end of clip

ESC Stop processing

Space Start/stop playback

Alt + Down Arrow Set in-point

Alt + Up Arrow Set out-point

Alt+Shift+J Select current frame field

111



Preferences


Some of the preferences below relate to Mocha Pro. Some

preferences may not be available in the Mocha Pro Plugin, Mocha

AE and Mocha HitFilm.

Preferences location

Preferences are accessed through File > Preferences on Windows or Linux

(Mocha Pro only) and Application Menu > Preferences on OS X.

Preferences are not changed until you click the OK button.

In some cases you will need to restart the Mocha application for preferences to

take effect.

You can also choose to reset all preferences back to the default using the

"Restore Defaults" button in the bottom left of the dialog.

Output Settings

File Storage

Output Directory (Standalone only)

The Output Directory settings specify the default location of the directory in which

the project file and rendered clips are stored. There is a choice between:

• Relative Path: The project directory is a subdirectory of the directory

containing the original project clip. By default, the subdirectory is Results. If

you often load your project clip over a network, it would be best not to choose

Relative Path, because the performance of project and clip I/O will not be as

fast as the local disk.

• Absolute Path: The project directory as an absolute path. For the best

performance choose a folder on a fast disk, with plenty of disk space available.

112



Autosave

The Autosave box is selected by default. This will automatically save the project

you are working on.

Set the interval between saves by increasing or decreasing the value in the

Interval (minutes) box.

The default is 5 minutes. If Save Images Every Frame is checked, rendered frames

are saved to disk as soon as they are created in memory; otherwise the render to

disk only occurs when rendering a sequence of frames.

You can define the Autosave directory or leave it to the system default.

In the standalone, if there is an autosave file available for the project you have

loaded, a dialog will appear asking if you want to open that instead.

In the plugin, the dialog will appear if there is an autosave available for a Mocha

project done in that host. You can then choose to open, save or remove the

project file.

For example, if you are working in After Effects and there is a problem, recovering

your AE project and opening the Mocha GUI will show a Mocha Autosave recovery

dialog for the project made in After Effects.

If you have other autosaves (for example from another Mocha Pro plugin host),

the recovery dialog will NOT appear, as it was a project made in another program.

An example autosave file is called:

"mochaAE_plugin-6_aftereffects-16.mocha.autosave"

This literally translates to: "Mocha AE Plugin project saved in After Effects v16".

In standalone, Autosave is per-project, i.e it will be directly related to the project

you are working on. This is because we work with a 1-to-1 match of the project file

name.

In the plugin, we can only save an autosave file per HOST, that is, we have no

knowledge of the project/layer that is being worked on, so we can only save

based on what we know, i.e the host the mocha project was saved in.
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This means that in the plugin, a crash from a previous project will trigger a load

prompt in ANY project you open created in the same host. For example:

1. Create an After Effects project with Mocha

2. Autosave kicks in

3. Force quit with mocha still open

4. Reopen host

5. Start or open another AE project with Mocha

6. Open mocha GUI

7. A Load-Autosave file prompt shows up

We time-stamp the autosave dialog so you can have a better idea of when the file

was saved, but if you open the autosave it will replace your existing work.

If your plugin autosave doesn’t automatically prompt to open, you can locate the

directory in the support path. By default these are:

• Windows: C:\Users\[username]\AppData\Roaming\BorisFX\Autosave

• macOS: ~/Library/Application Support/BorisFX/Autosave

• Linux: ~/.config/BorisFX/Autosave

You can then Open or Merge the file into a new or existing project.

Autosave Backups

We also back up each session autosave just in case a previous autosave has a

problem or you want to revert back to an older state.

You can define how many backups in the "Number of Backups field" next to the

Autosave interval field.

Autosave backups are saved to an "autosave_history" folder relative to the current

autosave file.

Cache Directory

Specify here the folder to use for caching image data and storing auto-saved
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project files. For the best performance, choose a folder on a fast disk with plenty

of disk space available. A lot of data is written out in the background while you

work, approximately three times as much disk space as the taken up by the

original clip will be used.

The Cache Original Clip box (Standalone only) is selected by default. This will

cache the original clip to the File Cache when a project is created or opened for a

more efficient playback and workflow. It is only necessary to check this if you are

getting footage from a slow network.

Disk Space Available

The available space in the given disk drive is shown here.

System

Application

Undo History Size

The Maximum Size of the history is the number of user interactions stored in the

undo/redo command list. The limit is used to conserve memory.

Maximum Memory Usage

The Maximum percentage of memory Mocha will attempt to use.

Maximum threads per thread-pool (Advanced)

This feature is to limit the number of threads Mocha will use on multi-core

machines.

On a machine with many cores, users may wish to limit the number of threads per

thread pool

to prevent Mocha from creating too many threads and potentially crashing.

We recommend turning this feature on if you experience frequent crashes when

rendering or tracking on high-core machines.

The default value will be the number of available cores. A value of 16 is a good

base value to start from.
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Track in Mocha AE

Check the box if you want to open Mocha Pro via the "Track in Mocha AE" option

inside After Effects, rather than loading the bundled Mocha AE.

UI Look and Feel

Number of Shown Layouts

Set how many layouts you want to appear in the View menu. The default is 3.

Field Controls

You can set either:

• Rotation Controls: Adjusts the value in the field by moving the mouse in a

circular motion. The larger the circle motion, the more refined the adjustment.

• Linear Controls: Drag left or right in the field to adjust the value.

Invert Mouse Wheel

Inverts the motion of when scrolling in a field increases the value or decreases it.

Enable mouse viewer scrolling

Toggles scrolling with the mouse wheel. This is on by default. There are two sub-

options:

• Mouse Wheel Scrubs Timeline: Sets the mouse wheel to scrub the timeline

when the cursor is over the viewer or the timeline.

• Mouse Wheel Zooms Viewer: Sets the mouse wheel to zoom in and out of the

viewer when the cursor is over the viewer.

If you hover over the timeline, it scrolls the timeline instead.

Tablet pressure sensitivity

Toggles whether Mocha reads tablet pressure sensitivity for tools such as the

Area Brush. On by default.
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Layer Settings

Default Colors

Defines the default colors for Splines, Mattes and Points

Default Opacity

Defines the default opacity for mattes

X-Spline Default Weight

Sets the default weight of the x-spline control points

Default Bezier Length

Sets the default normalized length of the bezier tangent handles.

GPU



Any changes to GPU settings requires a restart of Mocha. For

standalone, this is simply closing Mocha and reopening.

For the Mocha plugin, you need to restart the host environment to

reload the plugin completely.

Display

Use Vertical Sync

Enable vertical sync in the frame display. We highly recommend you keep this on.

Amount of Texture RAM to Reserve

The amount of memory that you want to be reserved for textures. This determines

how many frames can be played back in real-time.

Textured rendering may not be compatible with Microsoft Windows Remote

Desktop Connection.
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Stereo [Mocha Pro Only]

Here you can enable Active Stereo viewing mode if it is available to you.

Matte Rendering

By default, Mocha will generate matte clips and track mattes by rendering with

OpenGL to an offscreen buffer.

If Disable Offscreen Buffers is checked, Mocha will fall back to a software-based

matte rendering implementation which is slower and produces lower-quality

results, but will work on all hardware.

Most users should not need to use this option.

GPU Processing

This option is on by default and sets the planar tracker to use the graphics card

instead of the CPU.

If this option is disabled it means you do not have a supported graphics card for

GPU tracking.

OpenCL Device

This option lets you choose the graphics card you want to use for GPU tracking.

By default this is set to Automatic, which attempts to choose the best available

option.

Allow unsupported GPUs

This option lets you override the officially supported graphics card list and choose

any GPU on your system.

Use this option with care as it may lead to unstable results.

Software Update [Mocha Pro Only]

Settings to check for software updates.

Color

Handles defaults for OCIO color settings. See the OpenColorIO (OCIO) chapter for
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more details.

Clip

If you are working on a number of shots that share the same clip attributes (the

same video standard, frame rate and color space), it can be useful to set a default

clip setting. Then you will not have to re-enter the same clip information each time

you load a clip.

Defaults

FPS

Sets the default frame rate with a dropdown.

You can enter a custom number if you click inside the dropdown.

Custom PAR

Sets the default Custom option in Pixel Aspect Ratio

Frame Offset controls

Options to set you default timeline as frames or timecode, and set a fixed frame

offset.

Output matte clips

Check this option to output matte clips to disk when previewing mattes (this

option is only available in the standalone version of Mocha).

Revert in input clip

Check this option to revert to the source clip if there is an unrendered frame

displayed in the viewer.

A yellow warning telling you the frame is not rendered will appear over the source

frame.

Format

Setting the format defines what results are rendered out to, but also define what

your Cleanplate clips will be saved as.
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Integer result clip format

What to set you rendering result output to for integer clip formats. Currently the

choice is between DPX and TIFF.

Float result clip format

What to set you rendering result output to for float clip formats. Currently the

choice is between EXR and TIFF.

Float clips will be generated internally as 32-bit float, increasing the precision of

compositing operations but using more memory.

Interlacing

Select the Separate Fields button if you normally use field-based clips.

This will usually consist of a video clip with options for PAL (upper field first, also

used for SECAM) or NTSC (lower field first) field ordering. Separate Fields will de-

interlace the clip and display both fields. When a clip is rendered, the fields will

automatically be interlaced back together again. There is also a 3:2 Pulldown

option if you mainly work with 3:2 pulldown material.

Video Files

Read/write using

The footage handling process to use. The default is GStreamer. You also have the

option to use QuickTime.

Note that your choice of clip media handler does not affect the opening of image

sequences such as TIFF, DPX, EXR and so on.

It also doesn’t affect any host source material being opened from the Mocha Plug-

In, but will affect any clip media you import directly from disk.

GStreamer

This is a versatile media handling library for reading in various codecs and footage

containers.

GStreamer currently has limited support for writing out of clips. More will be
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available in later versions.

If you need to render out a clip to disk, we recommend using a lossless sequence

such as TIFF or DPX.

QuickTime

Open files using the QuickTime library. This will only open footage that QuickTime

can open.


QuickTime is unsupported on macOS 10.15 and above.

QuickTime will not work on systems that don’t have the QuickTime

essentials installed.

You must restart the host or the standalone application for any change to the

read/write settings.

Mask

Sets the default clip mask.

Lens [Mocha Pro Only]

Camera Model

Sets the default distortion mode.

Logging

Diagnostic Logging

Enable Diagnostic Logging

This is selected by default. The file generated is useful for Boris FX engineers to

diagnose error messages and fix any problems. You can view the log by selecting

View Log from the Help menu. You can also change the location of the Log File

from its default.

Verbose Mode
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This is set to off by default. If you are working on a labor-intensive project, you

can switch to only log errors as they occur, rather than constantly checking. This

provides less information in the event of an error, but can marginally improve

performance.

Verbose mode also logs render times. If you are interested in measuring render

performance in your projects, check your log after rendering.

Usage Data Collection

Turn on this option to periodically send anonymous usage data to Boris FX so we

can improve our products.

Crash and Error Reporting

Keep this option on to send anonymous crash and error data to Boris FX.

This is extremely useful for helping the Mocha team fix defects in future versions

and help narrow down problems.

Key Shortcuts

See the chapter on Keyboard Shortcuts for more information.
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Third Party Open Source and
Commercial Licenses Used by Mocha
Mocha uses the following third-party libraries and commercial licenses.

Where relevant, full license text is listed under each heading.

Qt 5.15.9

Qt is available under the GNU Lesser General Public License version 3.

The source code for Qt 5.15.9 can be obtained from https://github.com/boris-fx/

qt5/tree/bfx/5.15.9

License

            GNU LESSER GENERAL PUBLIC LICENSE

 The Qt Toolkit is Copyright (C) 2015 The Qt Company Ltd.
 Contact: http://www.qt.io/licensing/

 You may use, distribute and copy the Qt Toolkit under the terms of
 GNU Lesser General Public License version 3, which is displayed
below.
 This license makes reference to the version 3 of the GNU General
 Public License, which you can find in the LICENSE.GPLv3 file.

---------------------------------------------------------------------
----

            GNU LESSER GENERAL PUBLIC LICENSE
                Version 3, 29 June 2007

 Copyright © 2007 Free Software Foundation, Inc. <http://fsf.org/>
Everyone is permitted to copy and distribute verbatim copies of this
licensedocument, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates
the terms and conditions of version 3 of the GNU General Public
License, supplemented by the additional permissions listed below.

0. Additional Definitions.

 As used herein, “this License” refers to version 3 of the GNU Lesser
General Public License, and the “GNU GPL” refers to version 3 of the
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GNU General Public License.

 “The Library” refers to a covered work governed by this License,
other than an Application or a Combined Work as defined below.

 An “Application” is any work that makes use of an interface provided
by the Library, but which is not otherwise based on the Library.
Defining a subclass of a class defined by the Library is deemed a
mode
of using an interface provided by the Library.

 A “Combined Work” is a work produced by combining or linking an
Application with the Library. The particular version of the Library
with which the Combined Work was made is also called the “Linked
Version”.

 The “Minimal Corresponding Source” for a Combined Work means the
Corresponding Source for the Combined Work, excluding any source code
for portions of the Combined Work that, considered in isolation, are
based on the Application, and not on the Linked Version.

 The “Corresponding Application Code” for a Combined Work means the
object code and/or source code for the Application, including any
data
and utility programs needed for reproducing the Combined Work from
the
Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

 You may convey a covered work under sections 3 and 4 of this License
without being bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.

 If you modify a copy of the Library, and, in your modifications, a
facility refers to a function or data to be supplied by an
Application
that uses the facility (other than as an argument passed when the
facility is invoked), then you may convey a copy of the modified
version:

    a) under this License, provided that you make a good faith effort
    to ensure that, in the event an Application does not supply the
    function or data, the facility still operates, and performs
    whatever part of its purpose remains meaningful, or

    b) under the GNU GPL, with none of the additional permissions of
    this License applicable to that copy.
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3. Object Code Incorporating Material from Library Header Files.

 The object code form of an Application may incorporate material from
a header file that is part of the Library. You may convey such object
code under terms of your choice, provided that, if the incorporated
material is not limited to numerical parameters, data structure
layouts and accessors, or small macros, inline functions and
templates
(ten or fewer lines in length), you do both of the following:

    a) Give prominent notice with each copy of the object code that
    the Library is used in it and that the Library and its use are
    covered by this License.

    b) Accompany the object code with a copy of the GNU GPL and this
    license document.

4. Combined Works.

 You may convey a Combined Work under terms of your choice that,
taken
together, effectively do not restrict modification of the portions of
the Library contained in the Combined Work and reverse engineering
for
debugging such modifications, if you also do each of the following:

    a) Give prominent notice with each copy of the Combined Work that
    the Library is used in it and that the Library and its use are
    covered by this License.

    b) Accompany the Combined Work with a copy of the GNU GPL and
this
    license document.

    c) For a Combined Work that displays copyright notices during
    execution, include the copyright notice for the Library among
    these notices, as well as a reference directing the user to the
    copies of the GNU GPL and this license document.

    d) Do one of the following:

        0) Convey the Minimal Corresponding Source under the terms of
        this License, and the Corresponding Application Code in a
form
        suitable for, and under terms that permit, the user to
        recombine or relink the Application with a modified version
of
        the Linked Version to produce a modified Combined Work, in
the
        manner specified by section 6 of the GNU GPL for conveying

125



        Corresponding Source.

        1) Use a suitable shared library mechanism for linking with
        the Library. A suitable mechanism is one that (a) uses at run
        time a copy of the Library already present on the user's
        computer system, and (b) will operate properly with a
modified
        version of the Library that is interface-compatible with the
        Linked Version.

    e) Provide Installation Information, but only if you would
    otherwise be required to provide such information under section 6
    of the GNU GPL, and only to the extent that such information is
    necessary to install and execute a modified version of the
    Combined Work produced by recombining or relinking the
Application
    with a modified version of the Linked Version. (If you use option
    4d0, the Installation Information must accompany the Minimal
    Corresponding Source and Corresponding Application Code. If you
    use option 4d1, you must provide the Installation Information in
    the manner specified by section 6 of the GNU GPL for conveying
    Corresponding Source.)

5. Combined Libraries.

 You may place library facilities that are a work based on the
Library
side by side in a single library together with other library
facilities that are not Applications and are not covered by this
License, and convey such a combined library under terms of your
choice, if you do both of the following:

    a) Accompany the combined library with a copy of the same work
    based on the Library, uncombined with any other library
    facilities, conveyed under the terms of this License.

    b) Give prominent notice with the combined library that part of
    it is a work based on the Library, and explaining where to find
    the accompanying uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.

 The Free Software Foundation may publish revised and/or new versions
of the GNU Lesser General Public License from time to time. Such new
versions will be similar in spirit to the present version, but may
differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library
as you received it specifies that a certain numbered version of the
GNU Lesser General Public License “or any later version” applies to
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it, you have the option of following the terms and conditions either
of that published version or of any later version published by the
Free Software Foundation. If the Library as you received it does not
specify a version number of the GNU Lesser General Public License,
you may choose any version of the GNU Lesser General Public License
ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide
whether future versions of the GNU Lesser General Public License
shall
apply, that proxy's public statement of acceptance of any version is
permanent authorization for you to choose that version for the
Library.

OpenColorIO

License

Copyright Contributors to the OpenColorIO Project.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are
met:

* Redistributions of source code must retain the above copyright
  notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright
  notice, this list of conditions and the following disclaimer in the
  documentation and/or other materials provided with the
distribution.
* Neither the name of the copyright holder nor the names of its
  contributors may be used to endorse or promote products derived
from
  this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
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OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

OpenSSL

License

  LICENSE ISSUES
  ==============

  The OpenSSL toolkit stays under a double license, i.e. both the
conditions of
  the OpenSSL License and the original SSLeay license apply to the
toolkit.
  See below for the actual license texts.

  OpenSSL License
  ---------------

/*
====================================================================
 * Copyright (c) 1998-2018 The OpenSSL Project.  All rights reserved.
 *
 * Redistribution and use in source and binary forms, with or without
 * modification, are permitted provided that the following conditions
 * are met:
 *
 * 1. Redistributions of source code must retain the above copyright
 *    notice, this list of conditions and the following disclaimer.
 *
 * 2. Redistributions in binary form must reproduce the above
copyright
 *    notice, this list of conditions and the following disclaimer in
 *    the documentation and/or other materials provided with the
 *    distribution.
 *
 * 3. All advertising materials mentioning features or use of this
 *    software must display the following acknowledgment:
 *    "This product includes software developed by the OpenSSL
Project
 *    for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
 *
 * 4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be
used to
 *    endorse or promote products derived from this software without
 *    prior written permission. For written permission, please
contact
 *    openssl-core@openssl.org.
 *
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 * 5. Products derived from this software may not be called "OpenSSL"
 *    nor may "OpenSSL" appear in their names without prior written
 *    permission of the OpenSSL Project.
 *
 * 6. Redistributions of any form whatsoever must retain the
following
 *    acknowledgment:
 *    "This product includes software developed by the OpenSSL
Project
 *    for use in the OpenSSL Toolkit (http://www.openssl.org/)"
 *
 * THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
 * EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE
 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
 * PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
 * ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
 * SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
 * NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
 * LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT,
 * STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
 * ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED
 * OF THE POSSIBILITY OF SUCH DAMAGE.
 *
====================================================================
 *
 * This product includes cryptographic software written by Eric Young
 * (eay@cryptsoft.com).  This product includes software written by
Tim
 * Hudson (tjh@cryptsoft.com).
 *
 */

 Original SSLeay License
 -----------------------

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
 * All rights reserved.
 *
 * This package is an SSL implementation written
 * by Eric Young (eay@cryptsoft.com).
 * The implementation was written so as to conform with Netscapes
SSL.
 *
 * This library is free for commercial and non-commercial use as long
as
 * the following conditions are aheared to.  The following conditions
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 * apply to all code found in this distribution, be it the RC4, RSA,
 * lhash, DES, etc., code; not just the SSL code.  The SSL
documentation
 * included with this distribution is covered by the same copyright
terms
 * except that the holder is Tim Hudson (tjh@cryptsoft.com).
 *
 * Copyright remains Eric Young's, and as such any Copyright notices
in
 * the code are not to be removed.
 * If this package is used in a product, Eric Young should be given
attribution
 * as the author of the parts of the library used.
 * This can be in the form of a textual message at program startup or
 * in documentation (online or textual) provided with the package.
 *
 * Redistribution and use in source and binary forms, with or without
 * modification, are permitted provided that the following conditions
 * are met:
 * 1. Redistributions of source code must retain the copyright
 *    notice, this list of conditions and the following disclaimer.
 * 2. Redistributions in binary form must reproduce the above
copyright
 *    notice, this list of conditions and the following disclaimer in
the
 *    documentation and/or other materials provided with the
distribution.
 * 3. All advertising materials mentioning features or use of this
software
 *    must display the following acknowledgement:
 *    "This product includes cryptographic software written by
 *     Eric Young (eay@cryptsoft.com)"
 *    The word 'cryptographic' can be left out if the rouines from
the library
 *    being used are not cryptographic related :-).
 * 4. If you include any Windows specific code (or a derivative
thereof) from
 *    the apps directory (application code) you must include an
acknowledgement:
 *    "This product includes software written by Tim Hudson
(tjh@cryptsoft.com)"
 *
 * THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
 * ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE
 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE
 * ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE
LIABLE
 * FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
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CONSEQUENTIAL
 * DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS
 * OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION)
 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT
 * LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY
 * OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF
 * SUCH DAMAGE.
 *
 * The licence and distribution terms for any publically available
version or
 * derivative of this code cannot be changed.  i.e. this code cannot
simply be
 * copied and put under another distribution licence
 * [including the GNU Public Licence.]
 */

libpng

License

This copy of the libpng notices is provided for your convenience.  In
case of
any discrepancy between this copy and the notices in the file png.h
that is
included in the libpng distribution, the latter shall prevail.

COPYRIGHT NOTICE, DISCLAIMER, and LICENSE:

If you modify libpng you may insert additional notices immediately
following
this sentence.

This code is released under the libpng license.

libpng versions 1.0.7, July 1, 2000 through 1.6.35, July 15, 2018 are
Copyright (c) 2000-2002, 2004, 2006-2018 Glenn Randers-Pehrson, are
derived from libpng-1.0.6, and are distributed according to the same
disclaimer and license as libpng-1.0.6 with the following individuals
added to the list of Contributing Authors:

   Simon-Pierre Cadieux
   Eric S. Raymond
   Mans Rullgard
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   Cosmin Truta
   Gilles Vollant
   James Yu
   Mandar Sahastrabuddhe
   Google Inc.
   Vadim Barkov

and with the following additions to the disclaimer:

   There is no warranty against interference with your enjoyment of
the
   library or against infringement.  There is no warranty that our
   efforts or the library will fulfill any of your particular
purposes
   or needs.  This library is provided with all faults, and the
entire
   risk of satisfactory quality, performance, accuracy, and effort is
with
   the user.

Some files in the "contrib" directory and some configure-generated
files that are distributed with libpng have other copyright owners
and
are released under other open source licenses.

libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000,
are
Copyright (c) 1998-2000 Glenn Randers-Pehrson, are derived from
libpng-0.96, and are distributed according to the same disclaimer and
license as libpng-0.96, with the following individuals added to the
list
of Contributing Authors:

   Tom Lane
   Glenn Randers-Pehrson
   Willem van Schaik

libpng versions 0.89, June 1996, through 0.96, May 1997, are
Copyright (c) 1996-1997 Andreas Dilger, are derived from libpng-0.88,
and are distributed according to the same disclaimer and license as
libpng-0.88, with the following individuals added to the list of
Contributing Authors:

   John Bowler
   Kevin Bracey
   Sam Bushell
   Magnus Holmgren
   Greg Roelofs
   Tom Tanner
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Some files in the "scripts" directory have other copyright owners
but are released under this license.

libpng versions 0.5, May 1995, through 0.88, January 1996, are
Copyright (c) 1995-1996 Guy Eric Schalnat, Group 42, Inc.

For the purposes of this copyright and license, "Contributing
Authors"
is defined as the following set of individuals:

   Andreas Dilger
   Dave Martindale
   Guy Eric Schalnat
   Paul Schmidt
   Tim Wegner

The PNG Reference Library is supplied "AS IS".  The Contributing
Authors
and Group 42, Inc. disclaim all warranties, expressed or implied,
including, without limitation, the warranties of merchantability and
of
fitness for any purpose.  The Contributing Authors and Group 42, Inc.
assume no liability for direct, indirect, incidental, special,
exemplary,
or consequential damages, which may result from the use of the PNG
Reference Library, even if advised of the possibility of such damage.

Permission is hereby granted to use, copy, modify, and distribute
this
source code, or portions hereof, for any purpose, without fee,
subject
to the following restrictions:

  1. The origin of this source code must not be misrepresented.

  2. Altered versions must be plainly marked as such and must not
     be misrepresented as being the original source.

  3. This Copyright notice may not be removed or altered from any
     source or altered source distribution.

The Contributing Authors and Group 42, Inc. specifically permit,
without
fee, and encourage the use of this source code as a component to
supporting the PNG file format in commercial products.  If you use
this
source code in a product, acknowledgment is not required but would be
appreciated.

END OF COPYRIGHT NOTICE, DISCLAIMER, and LICENSE.
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TRADEMARK:

The name "libpng" has not been registered by the Copyright owner
as a trademark in any jurisdiction.  However, because libpng has
been distributed and maintained world-wide, continually since 1995,
the Copyright owner claims "common-law trademark protection" in any
jurisdiction where common-law trademark is recognized.

OSI CERTIFICATION:

Libpng is OSI Certified Open Source Software.  OSI Certified Open
Source is
a certification mark of the Open Source Initiative. OSI has not
addressed
the additional disclaimers inserted at version 1.0.7.

EXPORT CONTROL:

The Copyright owner believes that the Export Control Classification
Number (ECCN) for libpng is EAR99, which means not subject to export
controls or International Traffic in Arms Regulations (ITAR) because
it is open source, publicly available software, that does not contain
any encryption software.  See the EAR, paragraphs 734.3(b)(3) and
734.7(b).

Glenn Randers-Pehrson
glennrp at users.sourceforge.net
July 15, 2018

libjpeg

This software is based in part on the work of the Independent JPEG Group.

FBX SDK

The FBX SDK is supplied by Autodesk.

License

This software contains Autodesk® FBX® code developed by Autodesk,
Inc. Copyright 2018 Autodesk, Inc. All rights, reserved. Such code is
provided "as is" and Autodesk, Inc. disclaims any and all warranties,
whether express or implied, including without limitation the implied
warranties of merchantability, fitness for a particular purpose or
non-infringement of third party rights. In no event shall Autodesk,
Inc. be liable for any direct, indirect, incidental, special,
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exemplary, or consequential damages (including, but not limited to,
procurement of substitute goods or services; loss of use, data, or
profits; or business interruption) however caused and on any theory
of liability, whether in contract, strict liability, or tort
(including negligence or otherwise) arising in any way out of such
code.

OpenEXR

License

Copyright Contributors to the OpenEXR Project. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

FreeType

License

Portions of this software are copyright ©2009 The FreeType Project
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(www.freetype.org).
All rights reserved.

libtiff

License

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software
and
its documentation for any purpose is hereby granted without fee,
provided
that (i) the above copyright notices and this permission notice
appear in
all copies of the software and related documentation, and (ii) the
names of
Sam Leffler and Silicon Graphics may not be used in any advertising
or
publicity relating to the software without the specific, prior
written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY
KIND,
OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
PROFITS,
WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY
THEORY OF
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE
OF THIS SOFTWARE.

uuid

OSSP uuid uses the MIT license.

License

OSSP uuid -- uuid Library
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  Copyright (c) 2002-2008 Ralf S. Engelschall
  Copyright (c) 2002-2008 The OSSP Project

  This file is part of OSSP uuid, a uuid library which
  can be found at http://www.ossp.org/pkg/lib/uuid/.

  Permission to use, copy, modify, and distribute this software for
  any purpose with or without fee is hereby granted, provided that
  the above copyright notice and this permission notice appear in all
  copies.

  THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED
  WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF
  MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED.
  IN NO EVENT SHALL THE AUTHORS AND COPYRIGHT HOLDERS AND THEIR
  CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
  SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
  LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
  USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
  ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
  OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT
  OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
  SUCH DAMAGE.

libxml

License

Copyright (C) 1998-2012 Daniel Veillard.  All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining
a copy
of this software and associated documentation files (the "Software"),
to deal
in the Software without restriction, including without limitation the
rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or
sell
copies of the Software, and to permit persons to whom the Software is
fur-
nished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be
included in
all copies or substantial portions of the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FIT-
NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL
THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN
THE SOFTWARE.

libz

License

zlib.h -- interface of the 'zlib' general purpose compression library
 version 1.2.11, January 15th, 2017

 Copyright (C) 1995-2017 Jean-loup Gailly and Mark Adler

 This software is provided 'as-is', without any express or implied
 warranty.  In no event will the authors be held liable for any
damages
 arising from the use of this software.

 Permission is granted to anyone to use this software for any
purpose,
 including commercial applications, and to alter it and redistribute
it
 freely, subject to the following restrictions:

 1. The origin of this software must not be misrepresented; you must
not
    claim that you wrote the original software. If you use this
software
    in a product, an acknowledgment in the product documentation
would be
    appreciated but is not required.
 2. Altered source versions must be plainly marked as such, and must
not be
    misrepresented as being the original software.
 3. This notice may not be removed or altered from any source
distribution.

 Jean-loup Gailly        Mark Adler
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 jloup@gzip.org          madler@alumni.caltech.edu

Eigen

License

 Copyright (c) 2011, Intel Corporation. All rights reserved.

 Redistribution and use in source and binary forms, with or without
modification,
 are permitted provided that the following conditions are met:

 * Redistributions of source code must retain the above copyright
notice, this
   list of conditions and the following disclaimer.
 * Redistributions in binary form must reproduce the above copyright
notice,
   this list of conditions and the following disclaimer in the
documentation
   and/or other materials provided with the distribution.
 * Neither the name of Intel Corporation nor the names of its
contributors may
   be used to endorse or promote products derived from this software
without
   specific prior written permission.

 THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND
 ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED
 WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE
 DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR
 ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES
 (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES;
 LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON
 ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT
 (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS
 SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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OpenCV

License

By downloading, copying, installing or using the software you agree
to this license.
If you do not agree to this license, do not download, install,
copy or use the software.

                          License Agreement
               For Open Source Computer Vision Library
                       (3-clause BSD License)

Copyright (C) 2000-2020, Intel Corporation, all rights reserved.
Copyright (C) 2009-2011, Willow Garage Inc., all rights reserved.
Copyright (C) 2009-2016, NVIDIA Corporation, all rights reserved.
Copyright (C) 2010-2013, Advanced Micro Devices, Inc., all rights
reserved.
Copyright (C) 2015-2016, OpenCV Foundation, all rights reserved.
Copyright (C) 2015-2016, Itseez Inc., all rights reserved.
Copyright (C) 2019-2020, Xperience AI, all rights reserved.
Third party copyrights are property of their respective owners.

Redistribution and use in source and binary forms, with or without
modification,
are permitted provided that the following conditions are met:

  * Redistributions of source code must retain the above copyright
notice,
    this list of conditions and the following disclaimer.

  * Redistributions in binary form must reproduce the above copyright
notice,
    this list of conditions and the following disclaimer in the
documentation
    and/or other materials provided with the distribution.

  * Neither the names of the copyright holders nor the names of the
contributors
    may be used to endorse or promote products derived from this
software
    without specific prior written permission.

This software is provided by the copyright holders and contributors
"as is" and
any express or implied warranties, including, but not limited to, the
implied
warranties of merchantability and fitness for a particular purpose
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are disclaimed.
In no event shall copyright holders or contributors be liable for any
direct,
indirect, incidental, special, exemplary, or consequential damages
(including, but not limited to, procurement of substitute goods or
services;
loss of use, data, or profits; or business interruption) however
caused
and on any theory of liability, whether in contract, strict
liability,
or tort (including negligence or otherwise) arising in any way out of
the use of this software, even if advised of the possibility of such
damage.
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